
RAC6182 Industrial 
Computer for the 
Windows CE 
Operating System 

User 
Manual 



 

 

Publication 6182-UM001D-EN-P 

Important User Information Solid state equipment has operational characteristics differing from those of 
electromechanical equipment.  "Safety Guidelines for the Application, Installation, and 
Maintenance of Solid State Controls" (Publication SGI-1.1) describes some important 
differences between solid state equipment and hard-wired electromechanical devices.  
Because of this difference, and because of the wide variety of uses for solid state 
equipment, all persons responsible for applying this equipment must satisfy themselves 
that each intended application of this equipment is acceptable. 

In no event will Rockwell Automation be responsible or liable for indirect or 
consequential damages resulting from the use or application of this equipment. 

The examples and diagrams in this manual are included solely for illustrative purposes.  
Because of the many variables and requirements associated with any particular 
installation, Rockwell Automation cannot assume responsibility or liability for actual use 
based on the examples and diagrams. 

No patent liability is assumed by Rockwell Automation with respect to use of the 
information, circuits, equipment, or software described in this manual. 

Reproduction of the contents of this manual, in whole or in part, without written 
permission of Rockwell Automation is prohibited. 

Throughout this manual, we use notes to make you aware of safety considerations. 

 

ATTENTION:  Identifies information about practices or 
circumstances that can lead to personal injury or death, 
property damage, or economic loss. 

 
Important:  Identifies information that is especially important for successful application 
and understanding of the product. 
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Using this Manual 

Read this preface to familiarize yourself with the rest of the manual.  The 
preface covers the following topics: 

• who should use this manual 

• the purpose of the manual 

• contents of the manual 

• conventions used in this manual 

• Allen-Bradley support 
 

Use this manual if you are responsible for installing, using, or 
troubleshooting the RAC6182 Industrial Computer for the Windows CE 
Operating System.  

For users interested in writing their own application software for the 
RAC6182 Industrial Computer, you will need to order the 6189-SDK 
software development kit.  This catalog number includes a detailed 
technical manual describing how to develop software applications for the 
RAC6182 Industrial Computer, along with a complete library of 
RAC6182 interfaces and development tools on CD-ROM. 

This manual is a user guide for the RAC6182 Industrial Computer for the 
Windows CE Operating System.  It gives an overview of the system and 
describes procedures you use to: 

• install the RAC6182 Industrial Computer in a panel or enclosure 

• install and remove system components 

• run the system 

• troubleshoot the system 

Preface 

Who Should Use This 
Manual 

Purpose of this Manual 
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Chapter Title Contents 

 Preface Describes the purpose, background, and scope of 
this manual. Also specifies the intended audience. 

1 Computer Features Shows the different versions and features of the 
RAC6182 Industrial Computer. 

2 Installation  Describes how to install the RAC6182 Industrial 
Computer in a panel or enclosure. Also how to 
connect power, network, and relay output.  

3 Connecting External Devices Tells how to connect external devices to the 
various RAC6182 ports.  

4 Adding/Removing  Internal 
Components 

Gives procedures for adding/removing RAM and 
ROM memory, add-in PCI and PC cards. 

5 Installing and Removing Front 
Bezel Assembly Items 

Gives procedures for installing or removing front 
bezel items, including display backlight tubes. 

6 Initial Operation and Setup Tells how to start and checkout the system.  

7 Windows CE Operating System Provides an overview of the RAC6182 Windows 
CE operating system and its native applications 
and utilities.  

8 Keypad Operation Explains how the RAC6182 keypad functions, and 
how to use the Keypad configuration application. 

9 Display Settings Explains how to configure the RAC6182 display 
settings. 

10 Touchscreen Calibration Explains how to calibrate the touchscreen on the 
RAC6182 Industrial Computer. 

11 Hardware Monitor Explains how to use the Hardware Monitor 
application to perform hardware diagnostics. 

12 Watchdog Timer Explains how to use the Watchdog Timer 
application to reset the RAC6182 in case of 
lockup. 

13 Communications Configuration Explains how to configure the RAC6182 to 
communicate with a host computer. 

14 Managing User Applications Explains how to install and configure user 
applications on the RAC6182 computer using 
Microsoft ActiveSync.  Also tells how to move data 
files to and from the RAC6182 computer, and 
upgrade the operating system. 

15 System Troubleshooting Explains how to interpret and correct problems 
with the RAC6182 Industrial Computer. 

16 Maintenance Gives procedures for cleaning the RAC6182 
Industrial Computer display. 

17 Replacement Parts and 
Accessories 

Describes the replacement parts and accessories 
that are available for the RAC6182 Industrial 
Computer, with their corresponding part numbers. 

 

Contents of this Manual 
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Chapter Title Contents 

Appendix A Specifications Provides physical, electrical, environmental, and 
functional specifications. 

Appendix B Processor Board Specifications  Provides information on the RAC6182 Industrial 
Computer processor board. 

Appendix C RAC6182 Compatible Devices Lists the devices that are compatible with the 
RAC6182. 

Appendix D RAC6182 Point-to-Point 
Communications 

Describes how to connect the RAC6182 to various 
devices. 

 
 

The following conventions are used throughout this manual: 

• Bulleted lists such as this one provide information, not procedural 
steps. 

• Numbered lists provide sequential steps or hierarchical information. 
 

Allen-Bradley offers support services worldwide, with over 75 
Sales/Support Offices, 512 authorized Distributors and 260 authorized 
Systems Integrators located throughout the United States alone, plus 
Allen-Bradley representatives in every major country in the world. 

Local Product Support 

Contact your local Allen-Bradley representative for: 

• sales and order support 

• product technical training 

• warranty support 

• support service agreements 

Technical Product Assistance 

If you need to contact Allen-Bradley for technical assistance, please 
review the information in the System Troubleshooting chapter first.  
Then call your local Allen-Bradley representative or contact Allen-
Bradley technical support at (440) 646-5800. 

For additional product information and a description of the technical 
services available, visit the Rockwell Automation/Allen-Bradley Internet 
site at http://www.ab.com. 

Manual Conventions 

Allen-Bradley Support 
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Computer Features 

This chapter provides an overview of the RAC6182 Industrial Computer 
for the Windows CE Operating System including: 

• available versions 

• software 

• additional catalog items 
 

The RAC6182 is available with a variety of options: 

 

• Display and operator input 

- 7.7-in. STN display with touchscreen or touchscreen/keypad 
 combination 

- 12.1-in. TFT display with touchscreen or touchscreen/keypad 
 combination 

- No display 

• Storage capacity (DiskOnChip) 

• Dynamic SDRAM 

• ATA Flash PC card 

• PCI communication card option (DH+/DH-485) 

• Power Input (AC or DC) 

• Application software (RSView Studio Machine Edition Runtime) 

 

The RAC6182 Industrial Computer is comprised of a front bezel 
assembly and computer chassis.  The computer chassis is common to all 
RAC6182 versions, and contains the processor board, power supply, and 
add-in cards.  It is attached to the front bezel assembly with a hinge, so it 
can be easily opened for internal access.   

Chapter 1 

Chapter Objectives 

RAC6182 Industrial 
Computer Versions 
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The RAC6182 Industrial Computer is delivered with the following  
items: 

• Computer with preinstalled Windows CE operating system 

• Mounting clips (4) 

• Power supply terminal block 

• Output relay terminal block 

• RAC6182 Applications and Accessories CD-ROM  

• Installation Guide (Publication 6182-IN001A-EN-P) 

• Microsoft Windows CE License Agreement (Part 41061-185-01(A) 

• Software manuals and media for optional bundled software 
applications. 

 

The RAC6182 Computer contains several hardware features designed to 
make it a flexible computer platform for running industrial applications. 

• MIPS 225MHz 32-bit RISC Processor, with hardware floating point 
coprocessor. 

• 32MB-64MB DiskOnChip flash ROM, field upgradeable 

• 64MB-256MB Dynamic SDRAM, field upgradeable 

• 128KB battery-backed static RAM, for high speed persistent data 
storage 

• Battery-backed real time clock/calendar 

• Hardware voltage/temperature monitoring 

• Software-based watchdog timer  

• Diagnostic Relay Output. 

 

The RAC6182 Industrial Computer is shipped with a product-specific 
version of the Microsoft Window CE operating system already installed 
in the product.  This is a full installation of Windows CE, complete with 
the graphical Desktop, file management features, and Internet Explorer 
application.  Additional user application software may also be pre-
installed, depending on the RAC6182 version ordered. 

The Windows CE operating system is stored in a secured flash ROM 
location, and cannot be corrupted by any normal user or software 
applications.  Therefore, no Windows CE media is shipped with the 
RAC6182 product. The RAC6182 operating system can be field 
upgraded to new versions.  For instructions, refer to Chapter 15, 
Managing User Applications. 

RAC6182 Industrial 
Computer Packing List 

RAC6182 Hardware 

RAC6182 Software 
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New user applications can be field-installed on the RAC6182 Industrial 
Computer.  Chapter 15, Managing User Applications, describes the 
various methods for installing software applications.  The software 
vendor should also provide instructions for loading the application 
program. 

RAC6182 Applications and Accessories CD-ROM 

This CD-ROM delivered with the RAC6182 Industrial Computer 
contains the Microsoft ActiveSync application software, the RAC6182 
User Manual in Adobe Acrobat PDF format, the RAC6182-specific 
backup files, and some Windows CE application tools. 

Microsoft ActiveSync 
The RAC6182 Computer supports the Microsoft ActiveSync 
communication utility.  Chapter 15, Managing User Applications, 
describes how to install and use ActiveSync on a desktop PC.  The 
ActiveSync program is used to manage user applications and data files 
on the RAC6182 Computer.  The connection between RAC6182 and PC 
can be either an RS232 null modem cable (6189-2NMCBL) or through 
the Ethernet port. 

Note: To install Microsoft ActiveSync on a desktop PC for the 
first time, you must use a null modem serial cable. 

 
An ATA memory card can also be used to transfer files between a PC and 
the RAC6182 Computer.  Chapter 4, Adding/Removing Internal 
Components, describes how to install and remove PC cards on the 
RAC6182. 

RAC6182 User Manual 
An electronic copy of this manual (publication 6182-UM001D-EN-P) is 
distributed on the RAC6182 Applications and Accessories CD-ROM.  
The user manual file is in a PDF format.  A copy of the Acrobat reader 
software program is also shipped on this CD-ROM. 

RAC6182 Backup Files 
The RAC6182-specific operating system, program, and application files 
are shipped on the CD-ROM.  Chapter 15, Managing User Applications, 
describes the RAC6182-specific files stored on the DiskOnChip flash 
memory. 
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Windows CE Applications 
Some useful Windows CE utility programs are included on the RAC6182 
Applications and Accessories CD-ROM.  These utilities include network 
tools to verify Ethernet connections, a registry edit tool, and a scribble 
application to test the touchscreen.  See each application’s online help for 
details on the program’s features. 

6182 – 

1 

 

2 

 

3 

 

4 

 

5 

 

6 

 

7 

 

Position #1 - Bulletin Number 
6182 = Windows CE Industrial Computer 

Position #2 - Computer Base Unit (Check Factory for Availability) 
A = 120/240V ac computer chassis, 32M byte Flash ROM,  

1 PCI slot 
B = 18-32V dc computer chassis, 32M byte Flash ROM,  

1 PCI slot 

C = 120/240V ac computer chassis, 64M byte Flash ROM, 
1 PCI slot 

D = 18-32V dc computer chassis, 64M byte Flash ROM,  
1 PCI slot 

Position #3 - Display and Bezel 
A = Non-display brick 
D = 7.7-inch STN LCD, 640x480, keypad 
E = 7.7-inch STN LCD, 640x480, keypad & touchscreen 

G = 12.1-inch TFT LCD, 800x600, touchscreen 
H = 12.1-inch TFT LCD, 800x600, keypad 
I = 12.1-inch TFT LCD, 800x600, keypad & touchscreen 

Position #4 - Random Access Memory Size (RAM)  
A = 32M byte DIMM RAM (Not available with RSView ME v3.0) 
B = 64M byte DIMM RAM 

C = 128M byte DIMM RAM 
D = 256M byte DIMM RAM 

Position #5 - PCI Option Card 
A = 1784-PKTX PCI card (DH+ and DH-485 networks) Z = None 

Position #6 - PC Option Card 
A = 32MB ATA Flash Memory Card  
B = 40+MB ATA Flash Memory Card 

Z = None 

Position #7 - Operating System & Application Software 
A = Windows CE 2.12, RSView Machine Edition v1.0 (obsolete) 
B = Windows CE 3.0, RSView Machine Edition v1.5 (obsolete) 
C = Windows CE 3.0, RSView Machine Edition v2.0/v2.1(obsolete)
D = Windows CE 3.0, RSView Machine Edition v3.0 

Y = Windows CE 3.0, no application  
Z = Windows CE 2.12, no application (obsolete) 

 

RAC6182 Ordering 
Information 
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The following illustrations show the major features and controls of the 
display versions of the RAC6182 Industrial Computer. 

RAC6182 Computer – 7.7 in. Version with Keypad 

 

 

Features of the RAC6182 
Industrial Computer 
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RAC6182 Computer – 12.1 in. Version with Keypad 

 

RAC6182 Computer – 12.1 in. Version with Touchscreen 
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RAC6182 Computer Common Chassis 
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RAC6182 Industrial Computer Connectors 

 

 

 

WARNING:  EXPLOSION HAZARD!  Substitution of 
components may impair suitability for Class I, Div 2 
hazardous locations. 
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The following table shows the LED indicators on the RAC6182 
Industrial Computer.   

Table A 
LED Indicators (Display Versions Only) 

Indicator Position Color Indicates 

 
Right Red Diagnostics.  Indicates that one of the 

following conditions exists when lit: 

  Overtemperature. Temperature inside 
the RAC6182 Industrial Computer 
enclosure is above defined threshold. 

  Voltage.  Voltages not within 
specification. 

Refer to Chapter 16, System 
Troubleshooting, for information on 
resolving diagnostic conditions. 

 
Center Green Numlock key activated when lit 

 
Left Green Power On when lit 

 
Note: The LEDs toggle on and off during power up. 

 
 

LED Indicators 
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Installation 

This chapter describes installation of the RAC6182 Industrial Computer 
for the Windows CE Operating System, including how to install the 
RAC6182 Industrial Computer in a panel using mounting clips. 

The RAC6182 Industrial Computer meets the European Union Directive 
requirements when installed within the European Union or EEA regions 
and has the CE mark.  A copy of the Declaration of Conformity is 
available at the Rockwell Automation/Allen-Bradley Internet site: 
www.ab.com 

Mount the RAC6182 Industrial Computer in a panel or enclosure to 
protect the internal circuitry.  Versions with a gasketed bezel meet 
NEMA Type 1, 12, 13 and 4X (Indoor use) and IEC IP54, IP65 only 
when properly mounted in a panel or enclosure having an equivalent 
rating. The non-display version does not have a gasket and has a NEMA 
Type 1 and IEC IP2X rating. 

Allow enough room within the enclosure for adequate ventilation.  Also 
consider heat produced by other devices in the enclosure.  The ambient 
temperature around the RAC6182 Industrial Computer must be 
maintained between 0o and 50 oC (32 o to 122 o F).  The RAC6182 
Industrial Computer is intended for use in Pollution Degree 2 
environments. 

Make sure you provide provisions for accessing the top, bottom, and side 
panels of the RAC6182 Industrial Computer to install/remove 
components and to access the connectors. 

Versions of the RAC6182 Industrial Computer with a display are shipped 
with the following mounting hardware: 

Table B 
Mounting Hardware 

Item Description Quantity Use For 

 

Mounting 
Clips 

4 Clips  Panel or enclosure 
mounting 

 

Chapter 2 

Chapter Objectives 

European Union 
Compliance 

Environmental 
Considerations 

Mounting Hardware 
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The following replacement clips can be ordered from Rockwell 
Automation: 

Part Number Description Quantity Use For 

6189-2MTGKIT Mounting clips Package of 4 
clips 

Replacement item 

 
In addition to the tools required to make the cutout, you will need a 
#2 Phillips-head screwdriver and a torque wrench. 
 

Allow adequate space for mounting, air flow, and maintenance.  The 
figure below shows recommended minimum clearances to other 
components within the rack or enclosure. 

 

ATTENTION: The RAC6182 Industrial Computer should 
not be operated within a confined space of the dimensions 
shown below unless adequate ventilation or other cooling 
methods are used to lower the air temperature within the 
enclosure. 

 

 

Tools Required 

Mounting Clearances 
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The following figures show the mounting dimensions for the RAC6182 
Industrial Computer. 

Note: Measurements in these figures are expressed in millimeters 
[inches]. 

 

7.7 in. Version with Keypad 

 

12.1 in. Version with Keypad 

 

Mounting Dimensions   
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12.1 in. Version with Touchscreen 

 

Non-Display Version 
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The following figure provides the dimensions for making the panel or 
enclosure cutout for the RAC6182 Industrial Computer.   

 

 
Table C 
Mounting Cutout Sizes 

Display Size Height Width 

7.7 in. version with keypad 197.8 [7.79] 295.8 [11.65] 

12.1 in. version with touchscreen 256.8 [10.11] 337.6 [13.29] 

12.1 in. version with keypad 256.8 [10.11] 389.9 [15.35] 
 
 

To install the RAC6182 Industrial Computer in a panel: 

 

ATTENTION: Disconnect all electrical power from the 
panel before making cutout. 

Make sure the area around the panel cutout is clear. 

Take precautions so that metal cuttings do not enter any 
components that are already installed in the panel. 

Failure to follow these warnings may result in personal 
injury or damage to the panel components. 

 
To install the RAC6182 Industrial Computer in a panel: 
1. Cut an opening in the panel using the panel cutout dimensions 

provided on Page 2-5. 

2. Make sure the RAC6182 Industrial Computer sealing gasket is 
properly positioned on the terminal.  This gasket forms a 
compression type seal.  Do not use sealing compounds. 

3. Place the RAC6182 Industrial Computer in the panel cutout.    

Mounting Cutouts 

Panel Mounting 
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4. Install the mounting clips.  The mounting clips slide into the slots on 
the top and bottom of the RAC6182 Industrial Computer.   

 

 
5. Gradually tighten the clips one at a time around the bezel using the 

specified sequence.  Repeat this process at least three times until the 
clips are hand-tight and the gasket is compressed uniformly against 
the panel. 

6. Tighten mounting clips to a torque of 10 in–lbs (1.1 N•m) in the 
sequence shown above.  Do not over–tighten. 

 

ATTENTION: Tighten mounting clips to a torque of 
10 in–lbs (1.1 N•m) to provide a proper seal and prevent 
damage to the RAC6182 Industrial Computer.  Allen–
Bradley assumes no responsibility for water or chemical 
damage to the terminal or other equipment within the 
enclosure because of improper installation. 
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A three-contact removable terminal block is used to connect power to the 
RAC6182 Industrial Computer.  The RAC6182 Industrial Computer AC 
version accepts 120/240V AC.  The AC power supply is autoranging. 
The DC version accepts 18-32V DC.   The removable terminal blocks 
are different on the AC and DC versions and cannot be interchanged. 

 

ATTENTION: The power supply must be connected to 
an earth ground.  Failure to follow this warning could 
result in severe electrical shock. 

 

 

 

ATTENTION:  Some 1784 communication cards have a 
connector like the one used for the RAC6182 power 
connector.  Do not plug power into connectors on these 
cards. 

 
The terminal block is equipped with two retainer screws to prevent 
accidental interruption of power to the RAC6182 Industrial Computer.  
Tighten the screws on the AC version to a torque of 5 in–lbs (0.56 N•m). 
Tighten the screws on the DC version to a torque of 2.5 in–lbs (0.28 
N•m). 

 

WARNING:  EXPLOSION HAZARD!  Do not connect 
or disconnect equipment unless power has been switched 
off or the area is known to be non-hazardous. 

 

Power Connections 
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A 3-part kit with the terminal blocks can be ordered from Rockwell 
Automation: 

Part Number Description 

6189-2CONN 120/240VAC Unit terminal block (qty 1)  

24VDC Unit terminal block (qty 1) 

Relay output terminal block (qty 1) 
 
 

The RAC6182 Industrial Computer has a relay output.  This output is a 
normally-open hard contact relay rated for 24VDC, 500mA.  A two-
contact removable terminal block is used to connect to the relay output.   

 

 
The terminal block is equipped with two retainer screws to prevent 
accidental disconnection.  Tighten these screws to a torque of 5 in–lbs 
(0.56 N•m). 

A 3-part kit with the terminal blocks can be ordered from Rockwell 
Automation: 

Part Number Description 

6189-2CONN Relay output terminal block (qty 1) 

120/240VAC Unit terminal block (qty 1)  

24VDC Unit terminal block (qty 1) 
 

  

Relay Output 



 

 

Connecting External Devices 

This chapter describes how to connect a variety of external devices to the 
RAC6182 Computer.  This chapter’s topics include: 

• USB devices 

• PS/2 keyboard and mouse 

• Ethernet network connection (RJ45) 

• Serial devices 

• Parallel devices 

• External video monitors 

• Relay output  

 

Make sure you disconnect all power to the RAC6182 Industrial 
Computer before performing any of the operations described in this 
chapter. 

 

ATTENTION: Disconnect all power from the RAC6182 
Industrial Computer and external devices before making 
any connections.  Failure to disconnect power could result 
in damage to the RAC6182 Industrial Computer and/or 
external device. 

 
As with all electronic devices, internal RAC6182 Industrial Computer 
components may be damaged by Electrostatic Discharge (ESD).  Do not 
touch connector pins when attaching external cables.  Touch the metal 
chassis to discharge yourself before connecting external cables. 

Chapter 3 

Chapter Objectives 

Safety Precautions 
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The RAC6182 Computer has two USB ports.  The Windows CE 
operating system currently only supports standard USB keyboard and 
mouse devices with its native device drivers.  A vendor-specific 
Windows CE driver will be required for all other USB devices. 

The USB device can plug into either of the two side panel USB ports as 
shown below.  While the USB interface is designed to be connected and 
disconnected under power, the Windows CE operating system will not 
automatically recognize any changes made under power.  

 

Table D 
USB Stacked Connector Pin-Out 

PIN Signal 
1 USB0VCC (Switched FET current protected) 
2 USB0D- 
3 USB0D+ 
4 USB0GND 
5 USB1VCC (Switched FET current protected) 
6 USB1D- 
7 USB1D+ 
8 USB1GND 
9 SHLDGND 
10 SHLDGND 

 

Connecting USB Devices 
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The mouse and keyboard plug into the side panel mouse and keyboard 
ports as shown below.  Any standard PS/2 keyboard and mouse devices 
can be used.  Both devices must be connected before power-up to be 
recognized by the Windows CE operating system. 

 

Table E 
PS/2 Port Connector Pin-Out 

PIN Signal 
1 KBDATA 
2 Not connected 
3 GND 
4 VCC 
5 KBCLK 
6 Not connected 
7 MSDATA 
8 Not connected 
9 GND 
10 VCC 
11 MSCLK 
12 Not connected 
13 Shield Ground 
14 Shield Ground 
15 Shield Ground 
16 Shield Ground 
17 Shield Ground 

 

Connecting PS/2 
Keyboard and Mouse 



3–4 Connecting External Devices 

 

Publication 6182-UM001D-EN-P 

The RAC6182 Industrial Computer accommodates CAT5 twisted pair 
Ethernet cabling with RJ45 connectors to support 10 Mbps and 100 
Mbps network data transfer rates.  Shielded cabling is required to 
maintain EMI compliance. 

A ferrite collar is included with the RAC6182 and is intended for use 
with an Ethernet cable connected to a RAC6182.  Install the collar for 
suppression of electromagnetic emissions and interference.  The collar is 
required for compliance with the European EMC directive. 

To be effective, the ferrite collar must be placed on the cable where the 
cable exits the RAC6182. 

To install the ferrite collar: 
1. Fold the collar so that it encircles the cable. 

2. Press the plastic housing until the collar snaps together. 

3. Check that the collar is fully latched. 

Ferrite Collar
Folded Around Cable

Open Ferrite Collar
(Side View)  

 

Note: For information on connecting the RAC6182 Industrial 
Computer to a host PC using the Ethernet connection, refer 
to Chapter 14, Communications Configuration. 

 

Connecting to an Ethernet 
Network 
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Important: Performance degradation of your Ethernet communications 
is likely to result if the unit or cables are subjected to 
extreme radiated or conducted high-frequency noise.  It is 
the user’s responsibility to properly route cables and 
condition input power in order to improve communication 
reliability. 
 
Proper cable routing and power conditioning is required to 
ensure reliable Ethernet communications in industrial 
environments.  Rockwell Automation recommends that all 
Ethernet cabling be routed through dedicated metal 
conduits.  Installing ferrite bead filters at cable ends may 
also improve reliability. 

 
Table F 
RJ45 Ethernet Connector Pin-Out 

PIN Signal 
1 LANTX+ 
2 LANTX- 
3 LANRX+ 
4 LANGND 
5 LANGND 
6 LANRX- 
7 LANTXDBN 
8 LANRXDAN 
9 LANSHLD1 
10 LANSHLD2 
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The RAC6182 Computer has two serial ports – COM1 and COM2, both 
with DB9 male connectors.   

The COM1 port supports RS232, RS422, and RS485 physical signals.  
The COM1 physical signals are software-selectable.   

The COM2 port supports only RS232 physical signals.  The COM2 port 
is used to connect to a host PC using ActiveSync.   

Note: You must use a null modem cable (6189-2NMCBL) to 
connect the COM2 port to a host PC.  For information on 
the null modem cable, refer to Appendix D, RAC6182 
Point-to-Point Communications. 

 
Note: For information on connecting the RAC6182 Industrial 

Computer to a host PC using the serial port, refer to 
Chapter 14, Communications Configuration. 

 
Table G 
DB9 Male Connector Pin-Out 

 
PIN 

RS232 Signal 
(COM1 and COM2) 

RS422/RS485 Signal 
(COM1 Only) 

1 DCD TXD(+) 
2 RXD TXD(-) 
3 TXD RXD(+) 
4 DTR RXD(-) 
5 SGND SGND 
6 DSR DH485 TXENBL 
7 RTS Not connected 
8 CTS Not connected 
9 RI Not connected 

 

Connecting Serial 
Devices 
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The RAC6182 Computer has an ECP/EPP compatible parallel printer 
port with a DB25 female connector.  This port can be connected to a 
parallel printer.  The RAC6182 Windows CE operating system provides 
a PCL3 printer driver.  If other printers are to be used, you must provide 
the associated Windows CE printer driver if available. 

Table H 
Parallel Port DB25 Female Connector Pin-Out 

PIN Signal 
1 STROBE# 
2 PD0 
3 PD1 
4 PD2 
5 PD3 
6 PD4 
7 PD5 
8 PD6 
9 PD7 
10 ACK# 
11 BUSY 
12 ERROR 
13 SELECT 
14 AUTOFD# 
15 FAULT# 
16 INIT# 
17 SLCT IN# 
18 GROUND 
19 GROUND 
20 GROUND 
21 GROUND 
22 GROUND 
23 GROUND 
24 GROUND 
25 GROUND 

 

Connecting Parallel 
Devices 
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The RAC6182 Computer has an external HD15 video connector.  It can 
drive an external monitor with VGA, SVGA or XGA analog video 
signals.   

Note: For information on setting the video resolution and refresh 
rate for an external monitor, refer to Chapter 10, Display 
Settings. 

 
Table I 
HD15 Video Connector Pin-Out 

PIN Signal 
1 RED 
2 GREEN 
3 BLUE 
4 Not connected 
5 GND 
6 GND 
7 GND 
8 GND 
9 Not connected 
10 GND 
11 Not connected 
12 DDC_DATA (pull-up) 
13 HSYNC 
14 VSYNC 
15 DDC_CLK (pull-up) 
16 Shield ground 
17 SLCT IN# 

 

Connecting an External 
Video Monitor 
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The RAC6182 Industrial Computer has a relay output.  This output is a 
normally-open hard contact relay rated for 24VDC, 500mA.  A two-
contact removable terminal block is used to connect to the relay output.  

Note: For instructions on connecting the relay output, refer to 
Page 2-8. 

 
The relay output can be used to drive a variety of peripheral signaling 
devices such as a tower annunciator light or an audible alarm or buzzer.  
The output can also be connected to an embedded control system to 
signal a RAC6182-generated event.   

 

Connecting to Relay 
Output 
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Adding/Removing Internal 
Components 

This chapter describes how to open the chassis of the RAC6182 
Industrial Computer and remove or install: 

• PC add-in cards (PCMCIA)  

• PCI add-in card 

• RAM 

• DiskOnChip flash ROM 
 

The RAC6182 Industrial Computer contains line voltages.  Make sure 
you disconnect all power to the RAC6182 Industrial Computer before 
removing covers or access screws. 

 

ATTENTION: Disconnect all power from the RAC6182 
Industrial Computer before removing components.  
Failure to disconnect power could result in severe 
electrical shock or damage to the RAC6182 Industrial 
Computer. 

 
Internal RAC6182 Industrial Computer components may be damaged by 
Electrostatic Discharge (ESD).  Make sure you wear a grounding strap 
whenever handling circuit boards, memory modules or other internal 
components. 

 

ATTENTION:  Wear a wrist strap (well grounded) and 
perform work in a static safe environment. 

Electrostatic discharge can damage the RAC6182 
Industrial Computer and components. 

 
 

Chapter 4 

Chapter Objectives 

Safety Precautions 
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The RAC6182 Industrial Computer accommodates one PCI compatible 
add-in card.  Due to thermal considerations with the unit, total add-in 
power is limited to 7W of power dissipation (within the product 
enclosure). 

Table J 
PCI Card Current Limits  

Voltage Current Limit at Specified Voltage 

5V 1.0A 

3.3V 0.1A 

12V 0.1A 

-12V -0.05A 
 

This section shows how to open and close the RAC6182 chassis to 
access internal components. 

 

ATTENTION: Review safety precautions on Page 4-1 
before proceeding.  Failure to follow proper safety 
procedures could result in severe electrical shock or 
damage to the RAC6182 Industrial Computer. 

 
To open the chassis (display versions): 
1. Disconnect power from the RAC6182 Industrial Computer. 

2. Remove the 3 screws securing the chassis to the front bezel.  

 

 
3. Open the chassis away from the front bezel.  Be careful not to stress 

or disconnect the internal cables running between the chassis and 
front bezel. 

Thermal Considerations 
for Add-In Cards 

Opening or Removing the 
Chassis 
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To remove the chassis (display versions): 
1. To remove the chassis completely from the front bezel, carefully 

disconnect the internal cables from the chassis printed circuit board.   

2. Remove the set-screw in the hinge, and lift the back chassis off the 
front bezel hinges. 

 

 
To replace the chassis (display version): 
1. To replace the chassis, remount the chassis onto the front bezel 

hinges and reinstall the hinge set-screw.  Reconnect the cables to the 
chassis printed circuit board.   

2. To close the chassis, slowly hinge the chassis back against the front 
bezel.  Be careful not to pinch the internal cables.   

3. Reinstall the 3 screws to secure the chassis to the front bezel. Tighten 
the screws to a torque of 6 - 8 in–lbs (0.7 - 0.9 N•m). 

Important: For a replacement chassis assembly, order the RAC6182 
non-display unit with the required options (6182-xAxxxx). 
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To open the chassis (non-display versions): 
1. Disconnect power from the RAC6182 Industrial Computer. 

2. Remove the 4 nuts securing the chassis to the front plate.  

 

 
3. To close the chassis, reinstall the 4 nuts to secure the chassis to the 

front plate. Tighten the nuts to 6 - 8 in–lbs (0.7 - 0.9 N•m). 
 

One Type III PC card or two Type II PC cards (PCMCIA) may be 
installed in the RAC6182 computer.  While the RAC6182 PCMCIA slots 
are electrically compatible with any standard PC card, special Windows 
CE drivers are required to make the PC card function on the RAC6182 
computer.  Refer to the application program to make sure it supports the 
desired PC card. 

The following memory PC cards can be ordered from Rockwell 
Automation: 

Part Number Description 

6189-ATA32 32MB ATA flash PC card 

6189-ATA64 64MB ATA flash PC card 
 

 

ATTENTION: Review safety precautions on Page 4-1 
before proceeding.   

Failure to follow proper safety procedures could result in 
severe electrical shock or damage to the RAC6182 
Industrial Computer. 

 

 

ATTENTION: PC cards may be sensitive to ESD and 
require careful handling.  Hold cards only by the edges do 
not touch connectors.  After removing a card, place the 
PC card in an anti-static wrapper. 

Adding/Removing PC 
Cards (PCMCIA) 
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To install a PC card: 
1. Locate the PC card slots on the side of the RAC6182. 

2. Loosen the screw on the PC card retainer bracket covering the PC 
card slot, if necessary.  

3. Insert the PC card into the desired slot.  Make sure the PC card is 
fully seated and the slot ejector is out.  Up to 2 Type II cards can be 
installed in the RAC6182. 

Note: Most PC cards are hot-swappable on the RAC6182.  
You do not need to turn off power to the unit.  Install 
one PC card at a time to ensure correct installation. 

 
4. Position the PC card retainer over the PC card and slot ejector and 

tighten the screw. Tighten the screw to a torque of 6 - 8 in–lbs (0.7 - 
0.9 N•m). 

5. Load the associated software and drivers for the card, if needed.  The 
Windows CE operating system automatically recognizes compatible 
memory cards. 

6. Follow instructions in the associated PC card user manual to make 
any required external cable connections. 
 

To remove a PC card: 
1. Locate the PC card slots on the side of the RAC6182. 

Note: Most PC cards are hot-swappable on the RAC6182.  
You do not need to turn off power to remove the card.  
Remove one PC card at a time to ensure correct 
removal. 

 
2. Loosen the screw on the PC card retainer bracket and rotate the 

bracket to remove the PC card. 

3. Remove any external cables attached to the PC card. 

4. Press the slot ejector to unseat the PC card from the slot.  Remove 
the PC card and store in an anti-static wrapper. 

5. Position the PC card retainer over any remaining PC card and slot 
ejector and tighten the screw. Tighten the screw to a torque of 6 - 8 
in–lbs (0.7 - 0.9 N•m). 
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One PCI card can be installed in the RAC6182 computer.  While the 
RAC6182 expansion slot is electrically compatible with any standard 
half-length PCI card, special Windows CE drivers are required to make a 
PCI card function on the RAC6182 computer.  Refer to the application 
program to make sure it supports the desired PCI card. 

The following PCI cards are available as factory-installed RAC6182 
options, and are supported by Rockwell Software's RSView Machine 
Edition application version 1.0. 

Part Number Description 

1784-PKTX Single-channel DH+/RIO/DH485 network card 
 
 

 

ATTENTION: Review safety precautions and 
information on thermal considerations for add-in cards on 
Page 4-2 before proceeding.   

Failure to follow proper safety procedures could result in 
severe electrical shock or damage to the RAC6182 
Industrial Computer. 

 

 

ATTENTION: Add-in cards may be sensitive to ESD 
and require careful handling.  Hold cards only by the 
edges--do not touch connectors.  After removing a card, 
place the card on a flat static free surface, component side 
up.  Do not slide the card over any surface. 

 
To install a PCI card: 
To complete this procedure, you will need a #1 and a #2 Phillips head 
screwdriver. 

1. Turn off power to the RAC6182.  

2. Remove the 2 screws securing the top cover to the chassis. 

3. Remove the screw securing the slot cover and remove the slot cover. 

Adding/Removing a 
PCI Card 
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4. Hold the card by the edges and firmly press the card into the PCI 
connector.   

 

 
5. Align the notch in the board retainer with the threaded hole on the 

chassis and install the screw.  Hold the notch tightly against the 
screw before tightening. Tighten the screw to a torque of 6 - 8 in–lbs 
(0.7 - 0.9 N•m). 

6. Check any connectors on the PCI card to make sure they are 
centered in the chassis opening.   

7. Reinstall the screws to secure the top cover to the chassis. Tighten 
the screws to 6 - 8 in–lbs (0.7 - 0.9 N•m). 

8. Follow the PCI card user manual instructions when attaching any 
required external cables to the card. 

 

ATTENTION:  Some 1784 communication cards have a 
connector like the one used for the RAC6182 power 
connector.  Do not plug power into connectors on these 
cards. 

 
 

To remove a PCI card: 
1. Disconnect power from the RAC6182 computer. 

2. Remove the 2 screws securing the top cover to the chassis. 

3. Remove any external cables attached to the PCI card. 

4. Remove the screw securing the board retainer. 
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5. Hold the board at each end and carefully rock the board back and 
forth until the edge connectors pull free. 

6. Store the board in an anti-static wrapper. 

7. Install and secure a slot cover over the open slot. Tighten the screw 
to a torque of 6 - 8 in–lbs (0.7 - 0.9 N•m). 

8. Reinstall the screws to secure the top cover to the chassis. Tighten 
the screws to a torque of 6 - 8 in–lbs (0.7 - 0.9 N•m). 

 
The RAC6182 processor board contains one standard DIMM socket.  
The DIMM memory can be upgraded or replaced. 

The following DIMM modules can be ordered from Rockwell 
Automation: 

Part Number Description 

6189-DIMM64 64MB SDRAM DIMM 

6189-DIMM128 128MB SDRAM DIMM 

6189-1DIMM256 256MB SDRAM DIMM 
 

 

ATTENTION: DIMM memory modules are sensitive to 
ESD and require careful handling.  Hold memory 
modules only by the edges--do not touch connectors.  
After removing a module, place it into an anti-static 
wrapper.  Do not slide the module over any surface. 

 
To access the DIMM socket: 
1. Turn off power to the RAC6182. 

2. Remove the 2 screws securing the top cover to the chassis. 

3. Locate the DIMM socket on the processor board.    

   

Adding/Removing RAM 
Memory 
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4. To remove the memory module, release the socket latches and 
carefully pull the module out of the socket. 

 

 
5. Store the memory module in an anti-static wrapper. 

6. To install the memory module, carefully push the module into the 
socket.  Make sure the socket latches are engaged. 

7. Reinstall the screws to secure the top cover to the chassis. Tighten 
the screws to a torque of 6 - 8 in–lbs (0.7 - 0.9 N•m). 
 

The RAC6182 processor board contains a socketed DiskOnChip (DOC) 
flash memory device, which stores the Windows CE operating system 
and any loaded software applications and data.  This DOC flash memory 
can be upgraded or replaced.  A special Allen-Bradley DOC extraction 
tool is required to remove the original DOC device, and is included with 
the DOC removal/installation kit. 

 

ATTENTION: Replacing the DOC will require you to 
re-install the operating system and re-load all software 
applications and data.  For instructions on how to perform 
these operations, refer to Chapter 15, Managing User 
Applications, on page 15-1 

 

The following DiskOnChip flash memory devices can be ordered from 
Rockwell Automation: 

Part Number Description 

6189-2FL64 64MB flash DOC and chip extractor tool 
 

Adding/Removing 
DiskOnChip Memory 
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ATTENTION: The DOC memory is sensitive to ESD 
and requires careful handling.  Hold the DOC by the 
package – do not touch the pins. After removing the 
DOC, place the device in an anti-static wrapper. 

 
To access the DiskOnChip socket: 
1. Disconnect power to the RAC6182. 

2. Follow the procedures beginning on Page 4-2 to open the chassis.   

3. Locate the DOC socket on the processor board, as shown on the 
diagram below.    

 

4. Use the special DOC extraction tool to hook the edges of the DOC.  
Be careful to hook only the DOC with the extraction tool, and not 
the socket located directly below the DOC. 

DOC Extraction Tool

Chip Socket

DiskOnChip Device
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5. Remove the DOC from its socket.  Pull the device straight up.  Be 
careful not to bend or damage the DOC pins. 

 

ATTENTION:  Make sure to hook only the DOC with 
the extraction tool, and not the socket located directly 
below the DOC.  Do not pull the socket from the printed 
circuit board assembly.  Irreparable damage will result. 

 

6. Store the DOC memory in an anti-static wrapper. 

7. Before installing the new replacement DOC memory chip, be sure it 
is properly oriented with regard to the chip socket.  On one end of 
the DOC chip is a beveled corner, an inked notch, and a dot (see 
below). 

Beveled corner

Dot

Inked notch

DiskOnChip Device

 

The chip socket itself contains a notch on one end (see below). 

Chip Socket

Notch

 

Align the end of the DOC chip containing the inked notch, dot and 
beveled corner with the end of the chip socket containing the notch.  

8. To install the DOC memory chip, carefully align all the pins with the 
chip socket.  Gently push the pins into the socket until the chip is 
seated against the socket base.  Make sure not to bend any pins.  

9. Follow the procedures on Page 4-3 to close the chassis.   
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Installing/Removing Front Bezel 
Assembly Items 

This chapter describes how to replace items in the RAC6182 front bezel 
assembly.  The RAC6182 front bezel assembly consists of a plastic bezel 
with overlay (keypad and/or touchscreen), and a metal frame assembly 
that holds the LCD panel and associated interconnection circuit boards.  
The LCD panel has field-replaceable backlight tubes (12.1-in. versions 
only).  The keypad bezel versions have removable function key legend 
strips.  This chapter’s topics include: 

• Replacing bezel cables 

• Disassembling the front bezel  

• Replacing the front bezel plastic overlay 

• Replacing the backlight tubes 

• Installing keypad legend strips 
 

The RAC6182 Industrial Computer contains line voltages.  Make sure 
you disconnect all power to the RAC6182 Industrial Computer before 
performing any of the operations described in this chapter. 

 

ATTENTION: Disconnect all power from the RAC6182 
Industrial Computer before removing components.  
Failure to disconnect power could result in severe 
electrical shock or damage to the RAC6182 Industrial 
Computer. 

 

Chapter 5 

Chapter Objectives 

Safety Precautions 
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At times when repairing or replacing items on the front bezel assembly, 
you may need to disassemble the front bezel. You must disassemble the 
front bezel when you:  

• Replace the front bezel plastic overlay 

• Replace the vertical legend strips 
 

To prepare the front bezel for disassembly (all models): 
1. Remove the RAC6182 from the panel or enclosure. 

2. Follow the procedures on Page 4-2 to remove the computer chassis. 

3. Place the front bezel assembly on a flat surface, with the overlay side 
down.  Take care not to scratch or damage the overlay or display 
window. 
 

To disassemble the front bezel (7.7 in. display): 
1. Disconnect the keypad and touchscreen cables.  

 

 
2. Remove the 10 screws securing the metal frame and lift the metal 

frame away from the plastic bezel. 

3. To reassemble the front bezel assembly, thread the keypad and 
touchscreen cables through the hole in the metal frame.   

4. Reinstall the 10 screws to attach the metal frame to the plastic 
overlay assembly. Tighten the screws to a torque of 6 - 8 in–lbs (0.7 -
 0.9 N•m). 

5. Connect the keypad and touchscreen cables. 

6. Follow the procedures on Page 4-2 to reassemble the front bezel 
assembly to the computer chassis. 
 

Disassembling the Front 
Bezel  
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To disassemble the front bezel (12.1 in. display with keypad): 
1. Disconnect the keypad cable, touchscreen cable, backlight tube 

connectors, and the backlight power supply cable as indicated in the 
following figure:  

 

 
2. Remove the 6 screws securing the metal cover to the frame. 

 

 
3. If you are replacing the plastic bezel overlay or vertical legend 

strips, remove the 10 screws securing the metal frame and lift the 
metal frame away from the plastic bezel. 

4. To reassemble the front bezel assembly, thread the keypad and 
touchscreen cables through the hole in the metal frame.   

5. Reconnect the keypad cable, touchscreen cable, backlight tube 
connectors, and backlight power supply cable. 

6. If you are replacing the plastic bezel overlay or vertical legend 
strips, reinstall the 10 screws to attach the metal frame to the plastic 
overlay assembly. Tighten the screws to a torque of 6 - 8 in–lbs (0.7 -
 0.9 N•m). 
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7. Reinstall the 6 screws to attach the metal cover to the frame. Tighten 
the screws to a torque of 6 - 8 in–lbs (0.7 - 0.9 N•m). 

8. Follow the procedures on Page 4-2 to reassemble the front bezel 
assembly to the computer chassis. 
 

To disassemble the front bezel (12.1 in. display with touchscreen): 
1. Disconnect the backlight tube connectors as indicated in the 

following figure:  

 

 
2. Remove the 6 screws securing the metal cover to the frame.   

Note: The touchscreen controller board for the 12.1-in. 
touchscreen-only version is attached to the metal cover.  
Do not damage the touchscreen cable when loosening 
the cover.  

 
3. Disconnect the touchscreen cable and remove the cover. 

4. If you are replacing the plastic bezel overlay or vertical legend 
strips, remove the 10 screws securing the metal frame and lift the 
metal frame away from the plastic bezel. 

5. To reassemble the front bezel assembly, thread the touchscreen cable 
through the hole in the metal frame.   

6. If you are replacing the plastic bezel overlay or vertical legend 
strips, reinstall the 10 screws to attach the metal frame to the plastic 
overlay assembly. Tighten the screws to a torque of 6 - 8 in–lbs (0.7 -
 0.9 N•m). 

7. Replace the metal cover and reconnect the touchscreen cable. 
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8. Reconnect the backlight tube connectors and backlight power supply 
cable. 

9. Reinstall the 6 screws to attach the metal cover to the metal frame. 
Tighten the screws to a torque of 6 - 8 in–lbs (0.7 - 0.9 N•m). 

10. Follow the procedures on Page 4-2 to reassemble the front bezel 
assembly to the computer chassis. 
 

The plastic overlay on the RAC6182 Industrial Computer is field 
replaceable. You may need to replace the bezel if the bezel or a portion 
of a keypad is damaged. The plastic overlay assembly includes the 
plastic bezel, overlay, and legend strips only. 

To replace the front bezel overlay: 
1. Follow the procedures in this chapter to disassemble the front bezel. 

2. On the new plastic overlay assembly, remove any protective film 
from the inside display window.  Be careful to keep this surface 
clean, as it cannot be cleaned once assembled. 

3. If you are replacing the bezel overlay on a 12.1-in. version with 
touchscreen, you must additionally remove the LED board from the 
existing assembly.  The LED board is attached to the upper left 
corner of the front bezel assembly with 2 screws. 

 

 
4. If you are replacing the bezel overlay on a 12.1-in. version with 

touchscreen, attach the existing LED board to the new front bezel 
assembly using the 2 screws. Tighten the screws to 4 - 6 in–lbs (0.5 - 
0.6 N•m). 

5. Place the metal frame in the new plastic overlay assembly and thread 
any cables through the frame as required.   

Replacing the Front Bezel 
Plastic Overlay 
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6. Follow the procedures in this chapter to reassemble the front bezel, 
routing and connecting cables as required. 

7. Remove outside display window protective film and reinstall 
RAC6182 computer into panel or enclosure. 

The following are catalog numbers for the RAC6182 front bezel overlay 
assemblies.  These assemblies include the plastic bezel, overlay, and 
legend strips only.  They do not include the LCD panel or 
interconnection boards: 

Part Number Description 

6189-2BZL8K 7.7 in. keypad bezel overlay assembly 

6189-2BZL8KT 7.7 in. keypad & touchscreen bezel overlay assembly 

6189-2BZL12K 12.1 in. keypad bezel overlay assembly 

6189-2BZL12KT 12.1 in. keypad & touchscreen bezel overlay assembly 

6189-2BZL12T 12.1 in. touchscreen bezel overlay assembly 
 

 
The RAC6182 keypad versions contain three legend strips – one strip for 
the horizontal function keys located below the display and two strips for 
the vertical function keys located on either side of the display.  Each of 
these legend strips can be removed and replaced with custom printed 
versions.  Contact Rockwell Automation for more information on how to 
obtain customized legend strips. 

The standard legend strips shipped with the product are configured as 
follows: 

Legend Strip Description 

7.7 in. horizontal strip F1-F11 printed on exposed side, 
user-writable surface on the reverse side. 

7.7 in. left vertical strip K1-K8 printed on exposed side, 
user-writable surface on the reverse side. 

7.7 in. right vertical strip K9-K16 printed on exposed side, 
user-writable surface on the reverse side. 

12.1 in. horizontal strip F1-F14 printed on exposed side, 
user-writable surface on the reverse side. 

12.1 in. left vertical strip K1-K10 printed on exposed side, 
user-writable surface on the reverse side. 

12.1 in. right vertical strip K11-K20 printed on exposed side, 
user-writable surface on the reverse side. 

 
The following replacement legend strips can be ordered from Rockwell 
Automation. Each kit contains one each of the three legend strips – 
horizontal, left vertical, and right vertical strips.  They are configured as 
listed above with text printed on one side and a user-writable surface on 
the other side.  

Installing Keypad Legend 
Strips 
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Part Number Description 

6189-2KEYKIT8 7.7 in. bezel legend strip kit (3 pcs) 

6189-2KEYKIT12 12.1 in. bezel legend strip kit (3 pcs) 
 

To replace the horizontal legend strip (7.7 in. & 12.1 in. versions):  
1. Locate the exposed legend strip tab on the lower left side of the 

RAC6182 unit.  

 

 
2. Carefully pull on the tab to remove the installed legend strip. 

3. To insert the new legend strip, first slightly cup the strip and 
carefully push it into the bezel slot.  Short pushes will help slide the 
new strip fully into place. 

4. Verify the alignment of the legend strip text on the front overlay 
keys.  Adjust as needed by pushing or pulling slightly on the legend 
strip tab. 
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To replace the vertical legend strips (7.7 in. & 12.1 in. versions):  
1. Follow the procedures in this chapter to disassemble the front bezel. 

2. Place the front bezel plastic overlay facedown on a flat surface.  
Take care not to scratch the front overlay or display window.  Locate 
the two exposed legend strip tabs as shown.  

 

3. To remove the legend strips, carefully pull on the exposed tab. 

4. To the insert new legend strip, first slightly cup the strip and 
carefully push it into the bezel slot.  Short pushes will help slide the 
new strip fully into place. 

5. Verify the alignment of the legend strip text on the front overlay 
keys.  Adjust as needed by pushing or pulling slightly on the legend 
strip tab. 

6. Follow the procedures in this chapter to reassemble the front bezel, 
routing and connecting cables as required. 

 

 

 



 

 

Initial Operation and Setup 

This chapter provides information on: 

• operating recommendations 

• boot-up sequence 

• system reset 
 

Rockwell Automation recommends that you not operate the RAC6182 
Industrial Computer with covers removed.  An electrical shock hazard 
exists.  In addition, removing the covers disrupts air flow and may result 
in overheating.  All covers are required to maintain EMI compliance. 

Operator access is limited to the front panel of the RAC6182 Industrial 
Computer.  This includes the display, keypad, and touchscreen.  Access 
to components behind the rack or panel in which the RAC6182 Industrial 
Computer is installed is restricted to authorized and properly trained 
personnel. 

To boot up the system: 

1. Install the RAC6182 Industrial Computer using the procedures in the 
following chapters: 

  Chapter 2, Installation 

  Chapter 3, Connecting External Devices  

  Chapter 4, Adding/Removing Internal Components. 

2. Apply power.  The RAC6182 Industrial Computer performs a Power 
On Self Test (POST) in which it tests the internal hardware and 
software integrity.  The display is not immediately activated during 
the POST.  If any failures occur, the Fault LED is turned on and the 
boot process is terminated. 

3. Upon successful completion of the POST, the RAC6182 Industrial 
Computer loads the Microsoft Windows CE operating system from 
flash ROM into RAM.  The Desktop is displayed and any 
applications configured for auto-start are started. 

Chapter 6 

Chapter Objectives 

Operating 
Recommendations 

Operator Access 

System Checkout 
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Note: The entire power-up process takes approximately 20 
seconds.  The display is not active for a large portion of 
the boot time, but the front panel LEDs toggle to 
indicate that the RAC6182 Industrial Computer is 
powering up. 

 
4. Use the procedures in Chapter 15, Managing User Applications, to 

load and manage additional software applications and data files. 

5. If your system does not boot up, or if you notice other problems, 
refer to Chapter 16, System Troubleshooting. 

To reset the RAC6182 Industrial Computer, cycle external power to the 
unit.   

After resetting, the RAC6182 Industrial Computer begins the Power On 
Self Test (POST).  During reset, the RAC6182 Industrial Computer: 

• Clears RAM 

• Starts the POST 

• Loads the operating system 

• Starts designated applications. 

 

 

 

System Reset 



 

 

Windows CE Operating System 

This chapter provides information on: 

• Windows CE architecture 

• Windows CE programs 

• Using Windows CE 

• Control Panel applications 

• RAC6182 Computer memory usage 
 

The Windows CE operating system from Microsoft is designed to 
provide a portable, scalable, real-time operating system for embedded 
devices.  The modular design of Windows CE allows the application 
designer to include only those features required for the specific product 
application.  However, Windows CE is still a subset of the other 
Microsoft operating systems, and it runs Win32 applications. 

Windows CE Benefits 

There are two major differences between Windows CE and other 
Microsoft Windows operating systems.  Windows CE: 

• Has a small memory footprint requirement 

• Runs on a wide variety of processor architectures.  

The small memory footprint allows Windows CE to operate in small 
solid-state memory devices (8 MB typical).  In contrast, PC-based 
Windows require hundreds of megabytes of storage space.   

PC-based Windows applications operate only on Intel x86 compatible 
architectures. Embedded devices using Windows CE can use low-cost 
and low-power processors with optimal features and functionality for the 
specific application. 

Compiling Windows CE Applications 

While the Windows CE operating system brings a higher level of 
standardization to embedded computing devices, third-party software 
applications must still be compiled and tested to run on each Windows 
CE device.  The compilation is required to tailor the software application 
to the device’s processor and unique hardware features.   

Chapter 7 

Chapter Objectives 

Windows CE Architecture 



7–2 Windows CE Operating System 

 

Publication 6182-UM001D-EN-P 

Microsoft created hardware reference models for the Handheld (HPC) 
and the Pocket (PPC) PC so that third-party applications can run on these 
standard platforms.  There are no hardware standards for embedded 
devices.   

The RAC6182 Industrial Computer is largely compatible with HPC and 
PPC, so applications that are compiled for the MIPS or MIPSFP may run 
on the RAC6182. 
 

The Windows CE programs that come with the RAC6182 Computer are 
stored in flash memory and cannot be inadvertently lost.  Additional 
programs can be installed as described in Chapter 15, Managing User 
Applications.   

The RAC6182 Computer ships with the following programs preloaded: 

Table K 
RAC6182 Standard Applications 

Application Purpose 

Microsoft Internet 
Explorer 

Web browser. 

PC Link and 
ActiveSync 

Connects the RAC6182 to a desktop computer 
running ActiveSync. 

Control Panel A set of configuration tools for setting up the 
RAC6182. 

Microsoft Explorer 
(Shell) 

A user interface to the system much like a desktop 
PC. 

 
Terminal Services for thin client applications is included in the 
RAC6182 Accessories CD.  Refer to the Terminal Server Client wizard 
for installation procedures. 

There are other Windows CE programs available.  Most of these 
programs have been written for HPC devices, and some may run on the 
RAC6182 Industrial Computer.  Visit Microsoft Windows CE web site at 
http://www.microsoft.com/windowsce/ for more information on 
Windows CE programs. 

The RAC6182 Industrial Computer is available with Rockwell Software 
RSView Machine Edition CE operator interface program.  Refer to the 
associated software program’s user manual shipped with the RAC6182 
Industrial Computer for information about using that program. 

Installing Applications 

The RAC6182 Industrial Computer is designed for field-installation of 
third-party software programs. Chapter 15, Managing User Applications, 

RAC6182 Standard 
Windows CE Programs 
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discusses how to use Microsoft ActiveSync to install and remove 
application programs on the RAC6182 Industrial Computer.  Each 
application program must be compiled for the MIPS RISC processor.   

If the application program literature does not specifically identify the 
RAC6182 Industrial Computer as a compatible hardware platform, take 
caution if trying to install and run it on the RAC6182 platform.  While 
the program may operate on the MIPS processor, there could be conflicts 
on the RAC6182 Industrial Computer.  Testing is essential. 
 

The Windows CE operating system provides a user interface very similar 
to other Microsoft Windows operating systems.  This user interface has 
been simplified somewhat to reduce the memory footprint, so there are 
some minor differences between a desktop Windows interface and the 
Windows CE interface. 

The RAC6182 Industrial Computer has a keypad and/or touchscreen for 
operator input.  In addition, an external keyboard and mouse can be 
connected.  The Windows CE graphical interface simplifies interaction 
with the computer.  You simply select and move objects on the screen by 
tapping and dragging them using your finger or stylus on the 
touchscreen, or using an external mouse.   

Note: If you have difficulty selecting objects using the 
touchscreen, run the calibration program described in 
Chapter 11, Touchscreen Calibration. 

 

Start Menu and Taskbar 

The Start menu is used to run programs, configure settings, and open 
recently-used documents.  A single-click on the Start menu button on the 
bottom left of the screen brings up the menu.  Subsequent clicks select 
the program or item you want to open.  The key sequence Ctrl+Esc also 
activates the Start menu. 

Using Windows CE 
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The taskbar across the bottom of the screen contains buttons for 
programs already running, along with a status area and a Desktop icon.  
You can alternately minimize and maximize an open application by 
clicking on its taskbar button.  Double-clicking on any icon in the status 
area shows more information about that function.  A single-click on the 
Show Desktop button (far right side of taskbar) minimizes all open 
windows and displays the RAC6182 Industrial Computer Desktop.  You 
can close an application by clicking with the right mouse button on its 
taskbar button and choosing Close. 

 

Command Bar 

Each program window has a command bar located across its top.  This 
command bar contains pull-down menu names and toolbar buttons for 
the application. 

Click on a menu name or toolbar icon to interact with the specific 
program.  The Help (?) button on the right side of the command bar 
provides application-specific help.  The Exit (X) button on the far right 
side of the command bar exits the application.   
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There is no Minimize button on the Windows CE command bar. Click 
the taskbar button to minimize a program window, or use the Show 
Desktop button to minimize all open program windows. 

Finding Files 

Select Start-Programs-Windows Explorer to locate files on the RAC6182 
Industrial Computer.  You can alternately double-click the My Computer 
icon on the Desktop to open the Windows Explorer program.  Windows 
Explorer allows you to browse and manipulate the RAC6182 files and 
folders.  The Edit menu allows you to move files from one location to 
another using the Copy or Cut and Paste commands.  When you create 
and save a new file, it is stored in the My Documents folder unless you 
specify another location.  

Note: The RAC6182 Computer does not provide persistent 
storage of the My Documents folder.  All documents to be 
saved should be stored under the \Storage Card folder. 

 

Browsing Web Pages 

Select Start-Programs-Internet Explorer to view Web pages.  You can 
alternately double-click the Internet Explorer icon on the Desktop to 
open the Internet Explorer program.  To access pages stored on the 
RAC6182 Industrial Computer, use the File-Open command and select 
the Browse button to locate the file.  To view Internet or Intranet pages, 
type a URL in the Address box.   

Before you can access remote Web pages, the RAC6182 Industrial 
Computer must be connected to a network.  See Chapter 14, 
Communications Configuration, for configuring the Ethernet interface.  
Additional network settings such as a Proxy Server can be configured in 
the Internet Explorer application using the Options command under the 
View menu. 

The Microsoft Internet Explorer application is a functional subset of the 
PC version.  It offers many of the same features of the PC version, and 
can be used to view most Internet HTML web pages.  Some advanced 
web features may not be fully supported. 

Printing 

Some RAC6182 software applications may support printing.  To print 
from these applications, select the Print command from the File menu.  
An HP-compatible printer must be connected to the RAC6182 parallel 
port. 
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Configuring the RAC6182 Industrial Computer 

There are several user-configurable settings on the RAC6182 Industrial 
Computer.  These settings are accessed from the Windows CE Control 
Panel. Select Start-Settings-Control Panel to open the Control Panel 
window.  

The Windows CE operating system contains a number of native 
functions and interfaces.  Many of these features are very similar to other 
Microsoft Windows operating systems.  The Windows CE Control Panel 
contains the following common or native applications.  Click on the 
associated Control Panel icon and use the Help (?) button to learn more 
about each application’s usage. 

Table L 
 Control Panel Applications on the RAC6182 

Application Purpose 

Communications  Configuring the RAC6182 PC connections.  For 
more information, refer to Chapter 14. 

Date/Time  Setting the date and time on the RAC6182. 

Dialing  Proving a dial-up connection.  Use with a Windows 
CE compatible PC card modem. 

Display Configuring display and color settings, external 
video port, and setting LCD backlight and contrast 
settings. For more information, refer to Chapter 10. 

Keyboard Setting up a keyboard device. 

Keypad  Configuring RAC6182 keypad functionality. For 
more information, refer to Chapter 9. 

Mouse Setting up a mouse device. 

Network  Setting up Ethernet network connectivity. For more 
information, refer to Chapter 14. 

Regional settings  Setting clock and calendar, along with default 
number and currency formats. 

Touchscreen Calibrating the touchscreen and setting other 
touchscreen options. For more information, refer to 
Chapter 11. 

System  Listing system properties like memory allocation, 
device information, operating system version, 
bundled applications, and device registration. 

Hardware Monitor Viewing the RAC6182 voltage and temperature, 
resetting the fault LED, and viewing the event log. 

Watchdog Timer Starting or stopping the software watchdog timer. 
 

Control Panel 
Applications 
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The RAC6182 Industrial Computer has five internal memory areas.  
These are: 

• Boot flash ROM 

• DiskOnChip flash ROM (32MB typical) 

• Dynamic RAM (32MB typical) 

• Battery-backed non-volatile RAM (128KB) 

• Flash memory PC cards 
 

Boot Flash ROM 

The RAC6182 Industrial Computer’s boot flash ROM is used to power-
up the RAC6182 Industrial Computer, perform the power-up self tests, 
and load the Windows CE operating system from the DOC flash ROM 
into the dynamic RAM.  The boot flash ROM code is not user accessible. 

DiskOnChip Flash ROM  

The RAC6182 DiskOnChip (DOC) flash ROM is the main storage 
memory on the RAC6182 Industrial Computer.  The Windows CE 
operating system is stored in a protected segment of the DOC flash 
ROM.  User applications are also stored on the DOC.  Upon power-up, 
the operating system and any auto-start applications are transferred from 
the DOC to dynamic RAM, where they are executed.   

The remainder of the DOC flash ROM is a FAT partition that appears as 
a folder named \Storage Card in Windows CE.  Files stored here are 
persistent. 

Note: Only programs and files loaded in the \Storage Card folder 
are saved in the DOC flash ROM.  All other folders or files 
existing in DRAM and are lost when power is cycled. 

 

Dynamic RAM 

The RAC6182 dynamic RAM memory is split into two segments: 
storage memory and program memory.  The Control Panel System 
application has a slider control that determines the allocation mix 
between Storage and Program memory.  

The storage memory segment is a virtual RAM disk known as the Object 
Store.  It provides specialized storage for the Windows CE Registry, the 
Windows CE file system, and Windows CE system databases. The 

RAC6182 Memory Usage 
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RAM-based storage memory segment is not persistent as in HPC 
devices, so all files stored here must be re-created at every startup. 

The program memory segment provides traditional computer RAM-like 
functions for holding application code, heaps, stacks, and data at run-
time.  The RAC6182 Industrial Computer loads the Windows CE 
operating system and any auto-start applications from the DOC flash 
ROM into the program memory at power-up. 

Battery-Backed Non-Volatile RAM 

The battery-backed RAM memory is a small segment of persistent RAM 
memory that is available for any application to use.  An application 
accesses the non-volatile RAM using a specialized API. 

Flash Memory PC Cards 

The RAC6182 memory can be expanded using a non-volatile flash 
memory PC card.  When a flash memory card is installed, a new 
StorageCard2 or StorageCard3 icon is displayed under My Computer, 
and files in the memory card can be manipulated using the Windows 
Explorer program.   

Two PCMCIA Type2 cards or one PCMCIA Type 3 card may be used.  
These must be ATA compatible.  For information on compatible cards 
and for instructions on installing them, refer to Chapter 4, 
Adding/Removing Internal Components. 

 



 

 

Keypad Operation 

This chapter describes how to configure and operate the front bezel 
keypad on associated RAC6182 versions.  This chapter’s topics include: 

• Keypad operation 

• Keypad layout  

• Configuring the Keypad application 

 

The 7.7 in. and 12.1 in. display versions of the RAC6182 Industrial 
Computer are available with a front bezel keypad.  This keypad provides 
an operator interface to the RAC6182 Industrial Computer.  The 
RAC6182 keypad operates like an external PC keyboard, sending key 
press and key release information to the Windows CE operating system.  
Additional custom functionality is incorporated in the keypad design for 
industrial control applications. 

Note: The RAC6182 Industrial Computer supports up to 3 
keyboard interfaces simultaneously – the bezel keypad, an 
external PS/2 keyboard, and an external USB keyboard.  
Caution must be exercised when designing multiple-
interface systems, as simultaneous operation of multiple 
keyboards may cause unexpected actions. 

 
 

The RAC6182 keypad consists of a numeric keypad, control keys, 
navigation keys, and user-programmable function keys.  The 7.7 in. 
keypad and 12.1 in. keypad are the same, except the 12.1 in. version 
contains 7 more function keys. 

 

Note: 12.1 in. display version shown. 

Chapter 8 

Chapter Objectives 

Keypad Operation 

Keypad Layout  
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Numeric Keypad  

The numeric keypad contains the following keys.  The numeric keypad 
keys are blue.  The NUMLOCK key changes the key definitions as 
shown below.  The NUMLOCK status LED is lit when the NUMLOCK 
function is activated. 

Table M 
Numeric Keypad Functions 

Key NUMLOCK On NUMLOCK Off 
0 0 INS (insert) 
1 1 END (end) 
2 2   (down-arrow) 
3 3 PG DN (page down) 
4 4   (left-arrow) 
5 5 (none) 
6 6   (right-arrow) 
7 7 HOME (home) 
8 8   (up-arrow) 
9 9 PG UP (page up) 
. . DEL (delete) 
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Control & Navigation Keys  

The control and navigation keys are black.  They have the following key 
definitions. 

Table N 
Control and Navigation Keypad Functions 

Key Unshifted Shifted Description 
/ - - / Backslash or minus sign 
* + + * Asterisk or plus sign 
    Enter key 

CTRL   Control key 
ALT   Alternate key 
ESC   Escape key 

|   
 |  | (tab) |  (back tab) Tab key 

WIN   Windows key 
    Backspace key 

DEL   Delete key 
SHIFT   Shift key 
SPACE   Space key 

   Left-arrow key 
   Up-arrow key 
   Right-arrow key 
   Down-arrow key 
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Function Keys  

The function keys are located below and on either side of the display 
window.   

The 7.7 in. version has 11 function keys below the display (F1-F11), and 
a row of 8 function keys on each side of the display (K1-K8, K9-K16), 
for a total of 27 function keys.   

The 12.1 in. version has 14 function keys below the display (F1-F14), 
and a row of 10 function keys on each side of the display (K1-K10, K11-
K20), for a total of 34 function keys. 

The default key configurations are listed below.  The key identifier 
represents the factory-shipped legend strip characters. 

Table O 
Function Key (F-Key) Keypad Functions 

7.7 in. Key Default 12.1 in. Key Default 
F1 F1 F1 F1 
F2 F2 F2 F2 
F3 F3 F3 F3 
F4 F4 F4 F4 
F5 F5 F5 F5 
F6 F6 F6 F6 
F7 F7 F7 F7 
F8 F8 F8 F8 
F9 F9 F9 F9 
F10 F10 F10 F10 
F11 F11 F11 F11 

  F12 F12 
  F13 left Shift + F1 
  F14 left Shift + F2 
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Table P 
Function Key (K-Key) Keypad Functions 

7.7 in. Key Default 12.1 in. Key Default 
K1 right Alt + F1 K1 right Alt + F1 
K2 right Alt + F2 K2 right Alt + F2 
K3 right Alt + F3 K3 right Alt + F3 
K4 right Alt + F4 K4 right Alt + F4 
K5 right Alt + F5 K5 right Alt + F5 
K6 right Alt + F6 K6 right Alt + F6 
K7 right Alt + F7 K7 right Alt + F7 
K8 right Alt + F8 K8 right Alt + F8 
K9 right Alt + F9 K9 right Alt + F9 

K10 right Alt + F10 K10 right Alt + F10 
K11 right Alt + F11 K11 right Alt + F11 
K12 right Alt + F12 K12 right Alt + F12 
K13 right Shift + F1 K13 right Shift + F1 
K14 right Shift + F2 K14 right Shift + F2 
K15 right Shift + F3 K15 right Shift + F3 
K16 right Shift + F4 K16 right Shift + F4 

   K17 right Shift + F5 
   K18 right Shift + F6 
   K19 right Shift + F7 

   K20 right Shift + F8 

 

Specialized Keypad Functionality  

The RAC6182 keypad has unique user-configurable functionality to 
enhance its use in industrial control applications.  Configuring the 
RAC6182 keypad functionality is done using the Keypad application in 
the Windows CE Control Panel and the Keypad Configuration Utility. 

Note: A Keypad Configuration Utility (KCU) for the RAC6182 
Industrial Computer can be installed on a desktop PC from 
the RAC6182 Applications and Accessories CD.  See 
“Setting Up and Using the Keypad Configuration Utility 
Software” in this chapter on page 8-8 for more information. 

 
Repeat Mode 
Repeat mode is selected using the Repeat tab on the Control Panel 
Keypad application.  When enabled, a key that is held down sends out 
repeated "key-down" events until the key is released, and a last "key-up" 
event is sent.  The repeat rate, delay interval and the delay between the 
first key press and the repeating actions are user configurable.   

Function keys set for single-character mode exhibit typematic behavior.  
Function keys set for macro-string mode do not exhibit typematic or 
repeating behavior.  The factory default for all keys is repeat mode. The 
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Keypad Configuration Utility is required to program the function keys 
for different modes and characters. 

Multi-Key Lockout Mode  
Multi-key lockout mode disables any subsequent key presses while an 
existing function key is still depressed.  When enabled and a function 
key is pressed, all other key presses are ignored until the function key is 
released.  Likewise, if the Alt, Ctrl, or Shift keys are pressed, all function 
keys are inhibited until the modifier key is released.   

An abort option allows the immediate discontinuation of all key 
operations if a function key is depressed and any other key is pressed 
while the first key is held down.  Upon abort, the first key’s "key up" 
event is sent.  No other key actions are recognized until all keys are 
released.  Use the Control Panel Keypad application to select this mode.  
The factory default is unselected. 

Hold-Off Mode  
Hold-off mode allows the user to program a hold-off delay timer from 
100 milliseconds to 5 seconds.  When active, multiple key presses of the 
same key are ignored for the duration of the delay timer.  This mode acts 
against key teasing.  If a key is held down, the typematic rules still apply. 
Use the Control Panel Keypad application to configure this mode.  The 
factory default is unselected. 
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You configure the RAC6182 Industrial Computer keypad using the 
Keypad application in the Windows CE Control Panel. 

To change the keypad operation: 
1. To start the Keypad application, select Start-Settings-Control Panel.  

Select or double-click on the Keypad icon. 

 

2. On the Repeat tab, select the following options as necessary: 

  To enable repeating for all keys, select the Enable Character 
Repeat checkbox. 

  To adjust how much time elapses before characters repeat, drag 
the Repeat Delay slider control. 

  To adjust how quickly characters repeat when you hold down a 
key, drag the Repeat Rate slider control. 

 

Setting Up the Keypad  
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3. On the Multi-Key/Hold-Off tab, select the following options as 
necessary: 

  To enable hold-off for all programmable (blue) keys, select the 
Hold-Off Mode checkbox. 

  To adjust how much time must elapse before another 
programmable key is recognized, drag the Hold-Off Delay slider 
control. 

  To enable multi-key lockout for all programmable (blue) keys, 
select the Multi-Key Lockout Enable checkbox. 

  To enable multi-key lockout with abort for all programmable 
(blue) keys, select the Multi-Key Lockout Enable with Abort 
checkbox. 

 

4. Press Enter or click the OK button to save the settings and exit. 

  
The RAC6182 Industrial Computer Keypad Configuration Utility (KCU) 
is a PC-based program that allows you to modify, view, print, save, recall 
and download keypad configurations to any RAC6182 Industrial 
Computer with a keypad.  Keypad configurations are uploaded and 
downloaded from a PC to the RAC6182 computer using the ActiveSync 
program.  The Keypad Configuration Utility requires an ActiveSync 
connection between the RAC6182 and the PC. 

For each keypad configuration you can do the following to one or more 
keys: 

• Enable or disable 

• Re-establish the factory default setting 

• Assign a new key mapping 

• Assign a macro string 

• Assign a run program command 

Setting Up and Using the 
Keypad Configuration 
Utility Software 
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The resultant codes for single key are often referred to as the definition 
or mapping of the key.  The collection of all keys’ definitions is 
commonly called the Keypad Configuration. 

Hint: If you modify the Keypad Configuration, you should save 
the new configuration to a Keypad Configuration File 
(*.KY2).  This file can be downloaded into other RAC6182 
computers to provide the same keypad behavior, or used to 
reload the desired configuration into a replacement 
RAC6182 computer.   

 

The Keypad Configuration is stored in the RAC6182 registry.  At run-
time, a special program called the Keypad Handler (kh.dll) is a 
companion to the keypad driver.  The keypad driver submits each key 
press to the Keypad Handler, which uses the registry to determine how 
the key press should be translated and returned to the operating system.  
The Keypad Handler can inhibit the key press, launch a program, or 
return one or more codes.  The operating system then forwards the 
resultant code(s) to the application with current focus. 

System Requirements 

The RAC6182 Keypad Configuration Utility is a Microsoft Windows 
application that runs on an PC with Windows 9x, Windows NT, or 
Windows 2000.  ActiveSync 3.0 or greater with a serial or Ethernet 
connection to the RAC6182 is required.  The KCU program requires 
about 3MB of disk space.  There are no unique device drivers. 

Installing the Keypad Configuration Utility 

The Keypad Configuration Utility software is distributed on the 
RAC6182 Applications and Accessories CD with every RAC6182 
Industrial Computer.  It can also be obtained by contacting Allen-Bradley 
technical support at (440) 646-5800. 

To install the RAC6182 Keypad Configuration Utility software using Control 
Panel: 
1. Insert the CD named RAC6182 Applications and Accessories” into 

your CD drive. 

2. Click the Start button, click Settings, and then click the Control 
Panel. 

3. Click the Add Programs button or icon. 

4. Click the CD button and browse to the folder “Keypad Configuration 
Utility”. 
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5. Select and open the file named “setup.exe”. 

6. Follow the install instructions on the screen. 

To install the RAC6182 Keypad Configuration Utility software using Run: 
1. Insert the CD named RAC6182 Applications and Accessories into 

your CD drive. 

2. Click the Start button and select Run from the menu. 

3. Browse the CD to the folder “Keypad Configuration Utility”. 

4. Select and open the file named “setup.exe”. 

5. Follow the install instructions on the screen. 

To Uninstall the RAC6182 Keypad Configuration Utility software using 
Control Panel: 
1. Click the Start button, click Settings, and then click the Control 

Panel. 

2. Click the Remove Programs button or icon. 

3. Select the RAC6182 Keypad Configuration Utility from the list of 
currently installed programs. 

4. Click the Remove button or icon. 

5. Follow the install instructions on the screen. 

Configuration Files 

The RAC6182 Keypad Configuration Utility recognizes a file with the 
extension *.KY2 as a RAC6182 keypad configuration.  Opening a file 
with this extension should launch the RAC6182 Keypad Configuration 
Utility. 
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Connecting the RAC6182 Computer to the PC Computer 

When the RAC6182 Keypad configuration Utility runs, it first looks for 
an ActiveSync connection to a RAC6182 computer.  That is why 
essential first steps are to ensure that ActiveSync is installed on the PC 
and to establish an ActiveSync connection between the PC and the 
RAC6182 Industrial Computer.  The connection can be serial or 
Ethernet.  If you are unfamiliar with ActiveSync and RAC6182 
communications, please see Chapter 13, Communications Configuration, 
and Chapter 14, Managing User Applications. 

Note: ActiveSync 3.0 is distributed on the RAC6182 Applications 
and Accessories CD with every RAC6182 Industrial 
Computer. 

 

Using the Keypad Configuration Utility 

To run the Keypad Configuration Utility: 

1. On the RAC6182, run PC Link to start the ActiveSync connection. 

2. On the PC, open the Start menu.  Open the Programs submenu and 
select the RAC6182 Keypad Configuration Utility. 

3. Click on the icon to run the RAC6182 Keypad Configuration Utility. 

4. The Keypad Configuration Utility opens and shows the keypad and 
the current configuration that is stored in the registry of the 
RAC6182.  Depending on the type of RAC6182 Industrial 
Computer, the keypad will be either the 7.7 in. STN bezel with 27 
function keys or the 12.1 in. TFT bezel with 34 function keys. 
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The window that contains the keypad configuration stored on the 
RAC6182 computer is named RAC6182 Keypad Configuration. 

Figure 1 
7.7 in. Bezel with Keypad 

Figure 2 
12.1” Bezel with Keypad 
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You can now: 

• Modify the keypad configuration and download it to the RAC6182. 

• Modify the keypad configuration and save it as a *.KY2 file. 

• Recall and modify an existing keypad configuration (*.KY2 file) and 
download it to the RAC6182. 

 
Operations available from the menu bar are as follow: 

 
Select commands on 

this menu: 
To 

File Menu  Open, close, and save configuration files, print preview 
and print keypad configuration files. 

Edit Menu  Select all keys or just the programmable keys, 
enable/disable keys, restore default configuration, edit 
single key configurations, and set keypad behavior 
attributes. 

View Menu  Toggle the tool bar or status bar on or off, or view the 
keypad identifiers of the current Keypad Configuration. 

Window Menu  Opens a new window and arranges open windows and 
keypad icons. 

Help Menu  Display a list of help topics or the current version number 
of the 6181 Keypad Configuration Utility. 

 

RAC6182 Keypad Configuration Window 

A keypad configuration appears as a separate window.  Most operations 
are done within this window.  

You can: 

• enter a description of the Keypad Configuration. 

• open a saved Keypad Configuration file (*.KY2). 

• select one or more keys. 

• enable/disable all or specific keys. 

• set the default configuration for all the programmable keys or all the 
keys. 

• edit the definition of the programmable keys. 

  change a programmable key to a new key; e.g. F1   ‘a’ 

  assign a macro string to a programmable key; e.g. F2   “RAC6182” 

  assign a run program command to a programmable key; e.g. K1   
“\Windows\ipconfig.exe” 
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Entering a Keypad Description 

The text edit box appears near the center of the keypad configuration 
window and allows you to enter a description to identify the Keypad 
Configuration.  The text edit box accepts up to 128 characters.  To edit a 
description, simply click in the text edit box and start typing or editing 
the text. With the cursor in the text edit box, click the right mouse button 
to open the popup menu.  Use the commands on this menu to copy/cut, 
paste and delete selected text.  To select all the text in the description 
box, choose Select All from the popup menu.  The new keypad 
description can be downloaded to the RAC6182 when you select 
Download Keypad Configuration to RAC6182… on the File menu, or 
can be saved to a file when you select Save or Save As… on the File 
menu. 

 

Figure 3 
Text Description 
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Selecting Keys 

The table below shows how to select keys on the keypad.  You must 
select a key before you can enable or disable the key or modify its 
configuration. 

To Select: Do This: The result is: 

Single key  Click the left mouse 
button on the key.   

The selected key is 
highlighted with 
handles. 

Group of keys Click the left mouse 
button and drag the 
selection rectangle 
around the keys you 
want to select.   

The selected keys are 
highlighted with 
handles. 

All keys Choose Select All Keys 
from the Edit menu.   

All keys are highlighted  
with handles. 

All Programmable Keys Choose Select All 
Programmable Keys 
from the Edit menu. 

All programmable keys 
are highlighted with 
handles. 

Multiple Keys Click the left mouse 
button sequentially on 
the desired keys while 
holding down the Ctrl 
key.   

The selected keys are 
highlighted with 
handles. 

 

Enabling and Disabling Keys 

You can enable/disable all or specific keys on the keypad.  By default, 
all keys are initially enabled. 

To disable one or more keys: 
1. Select the key(s) you want to disable. 

2. Choose Enable Key from the Edit Menu or click the right mouse 
button on the key and choose Enable Key from the popup menu. 

A red X appears on the key, indicating that it is disabled and the check 
mark is removed from Enable Key on the Edit menu. 

To enable a key: 
1. Select the disabled key(s) that you want to enable. 

2. Choose Enable Key from the Edit Menu or click the right mouse 
button on the key and choose Enable Key from the popup menu. 

The red X is cleared from the key, and a check mark appears next to 
Enable Key on the Edit menu.  If multiple keys are selected with some 
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keys enabled and others disabled, choosing the Enable Key command 
will enable all the selected keys. 

Opening a Saved Keypad Configuration 

To open an existing keypad configuration file: 
1. Choose Open from the File menu or click on the tool bar. 

 

Figure 4 
Open File 

 
2. The dialog shows all keypad configuration files (*.KY2) in the 

“Look In:” folder. 

3. Double-click the *.KY2 file you want to open or click on a *.KY2 
file and then click the Open button.  A window opens for the selected 
keypad configuration.  The name of the *.KY2 file shows in the title 
bar. 

The window titled RAC6182 Keypad Configuration is the 
configuration stored on the RAC6182.  If this window and all other 
keypad configuration windows are closed, you can reopen the RAC6182 
Keypad Configuration from the File menu by selecting Open RAC6182 
Keypad Configuration from the File menu. 
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Set the Default Configuration for Programmable Keys 

1. Select one or more programmable keys or use the edit menu Select 
All Programmable Keys.  See “Selecting Keys” above. 

2. Choose Set Default Configuration from the Edit menu. 

 

Figure 5 
Set Programmable Key Default 

The selected programmable keys are set to their default assignments.  
The default key assignments are listed at the end of this chapter. 
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Set the Default Configuration for Any Key 

1. Select one or more keys or use the edit menu Select All Keys. See 
“Selecting Keys” above. 

2. Choose Set Default Configuration from the Edit menu. 

 

Figure 6 
Set Key Default 

The selected keys are set to their default assignments.  Non-
programmable keys are enabled by default.  The default key assignments 
are listed at the end of this chapter. 
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Editing the Programmable Keys 

To edit the definition of a programmable key: 
1. Select a single programmable key. 

2. Choose Key Configuration from the Edit menu or click the right 
mouse button on the key and choose Key Configuration from the 
popup menu as shown below. 

3. Use the Edit Programmable Key dialog to view the current definition 
and establish a new definition for the programmable key. 

4. Click OK or press Enter to save the definition and close the dialog. 

5. When all programmable keys are defined to your satisfaction, 
download the Keypad Configuration to the RAC6182. 

 

Figure 7 
Edit Configuration 
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The Edit Programmable Key dialog lets you modify the definition of the 
selected programmable key.  The definitions are downloaded and stored 
in the registry of the RAC6182.  Modifying a programmable key is not 
recommended unless required by the application software. 

 

Figure 8 
Select and Edit Programmable Key  

When the Edit Programmable Key dialog box opens, it shows the current 
definition of the selected programmable key.  Nonprintable key codes 
appear in brackets, for example, <F1> or <(L)Shift+F1>.  Modifiers 
appear to the left of a “+” symbol.  (L) or (R) denote left or right 
modifier keys.  The current mode is indicated in the Select Mode 
grouping. 
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Text Edit Box 

The text box at the top of the dialog displays the current definition for a 
selected programmable key.  You can enter a new definition directly into 
the edit box if the characters are printable (e.g., alphanumeric 
characters).  You must enter nonprintable characters from the Add New 
Code list.  While in the text edit box, use Backspace to remove existing 
characters and correct typing errors.  The contents of the Text Edit Box 
are transformed into key codes and/or run commands that are emitted 
when the key is pressed.  Note that one of the more powerful RAC6182 
keypad features is to perform multiple key codes with a single key press. 

 

Figure 9 
Edit Programmable Key Dialog 
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Select Mode 

Determines how the contents of the Text Edit Box will be handled by the 
RAC6182 when the selected key is pressed.  There are 3 modes, 
established by radio buttons. 

1. In Macro/String mode, the key is defined as non-repeating and all 
key codes are sent as a single string when the key is first pressed.  A 
key defined as a Macro/String can submit a sequence of up to 31 key 
presses to the application that is currently in focus.  
 
In the following example, the programmable key emits the well-
known, DOS “DIR command” to the command prompt.  The 
RAC6182 command prompt application window must be “in focus” 
on the RAC6182 before this macro string will work.  The command 
prompt can be opened from the Start menu:  START / PROGRAMS / 
COMMAND PROMPT. 

 

Figure 10 
Macro/String Mode 
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2. In Make/Break Typematic mode, the key is defined as repeatable at 
the Repeat Rate established by the Keypad Properties Tool in 
RAC6182 Control Panel.  The key “Make” codes are sent when the 
key is first pressed and the “Break” codes are sent when the key is 
released.  If the key is held down, the “Make” codes repeat at the 
Repeat Rate. 
 
Make/Break Typematic mode is available only for a single key press 
definition including its modifiers, and as such is typically used to 
map a programmable key to a single alpha key.  Thus the keypad can 
emulate a subset of a standard PC keyboard. 
 
In the following example the programmable key emits the character 
‘a’ at the Repeat Rate. 

 

Figure 11 
Make/Break Typematic Mode 
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3. In Run Program mode, the key is defined as non-repeating, and all 
key codes are sent as a single string when the key is first pressed.  A 
key defined as a Run Program can submit a sequence of up to 80 
characters.  Unlike the other modes, wherein actions are directed at 
the application with current focus, this action is directed at the 
operating system to run the program that is named in the Text Edit 
Box. 
 
In the following example, the key press launches a program named 
“ProgramName.exe”.  You cannot enter a path name in this field.  
You can only enter the program name.  So either locate a shortcut to 
the application in the search path (defined below) or follow the 
directions below for adding search paths to the RAC6182 registry. 

 

Figure 12 
Run Program Mode 

A programmable key in the Run Program mode calls the Win32 API call 
CreateProcess() with the name of an executable program.  Directories are 
searched in the following order: 

1. The Windows (\windows) directory 

2. The root (\) directory of the device 

3. OEM specified directories as follows: 
 
The registry subkey can specify a search path for the CreateProcess 
function: 
\HKEY_LOCAL_MACHINE\Loader 
           “SystemPath”=multi_sz:  \\path1\\ “\\path2\\” 
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Add New Code 

The Add New Code grouping on the dialog is a list of valid keys and 
modifiers that can be assigned to a programmable key.  A modifier (Shift, 
Ctrl, Alt, Win or Win Appl) are enabled for a key code, by selecting the 
appropriate check boxes.  These check boxes are dynamically updated so 
that only valid combinations are allowed.  After selecting a key code and 
modifiers, click the Enter button to display the new code in the Text Edit 
box.  You must click Enter after each new code selection.  Non-printable 
codes are enclosed within ‘<’ and ‘>’. 

Hints for editing a programmable key definition: 
• Select (or click on) a code in the Add New Code list. 

• Under Left or Right, select the Shift, Ctrl, Alt, or Win check boxes to 
enable one or more modifiers for the new code. 

• Click Enter to display the new code in the text box.  If entering 
multiple codes, click Enter after each code selection or double-click 
each code selection.  The text box is automatically updated. 

•  Type the characters in the Text box as you want them to appear using 
shifted or unshifted characters. 

•  To insert a nonprintable code in the text, select the code from the 
Add New Code list and then click Enter.  The nonprintable code is 
inserted in the text with brackets. 
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Examples of Editing Key Definitions 

Example #1: Configure the K1 key as < (L)Win+e > which runs Windows 
Explorer: 
1. Select the key labeled K1. 

2. Choose Key Configuration from the Edit menu, or click the right 
mouse button on the key and choose Key Configuration from the 
popup menu. 

3. In the text box, backspace to delete the current definition. 

4. Under Select Mode, select Make/Break Typematic. 

5. Select ’e’ from the Add New Code list. 

6. Under Left, check Win check box. 

7. Click the Enter button to display the new definition. 

 

Figure 13 
Example #1 

8. Click OK to store the definition and exit the dialog. 
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Example #2: Configure the K10 key perform a DIR /a /o /s command 
1. Select the key labeled K10. 

2. Choose Key Configuration from the Edit menu, or click the right 
mouse button on the key and choose Key Configuration from the 
popup menu. 

3. In the text box, backspace to delete the current definition 

4. Under Select Mode, select Macro/String 

5. In the text box, type DIR /a /o /s 

6. In the Add New Code list, select Enter and click the Enter button 

 

Figure 14 
Example #2 

7. Click OK to store the definition and exit the dialog. 
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Example #3: Configure the F6 key to run the program IPCONFIG.EXE 
1. Select the key labeled F6. 

2. Choose Key Configuration from the Edit menu, or click the right 
mouse button on the key and choose Key Configuration from the 
popup menu. 

3. Under Select Mode, Run Program. 

4. In the text box, type “ipconfig.exe” 

 

Figure 15 
Example #3 

5. Click OK to store the definition and exit the dialog. 
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Saving Keypad Configurations 

You can save a keypad configuration under the existing name or under a 
new name. 

Save 
Choose Save from the File menu or click on the tool bar to save changes 
to a keypad configuration under the current name.  The default filename 
for the keypad configuration is RAC6182.KY2.  The first time you try to 
save a configuration, the Save As dialog opens. 

Save As 
Choose Save As from the File menu to save the keypad configuration 
under a new file name.  The default file type for a RAC6182 keypad 
configuration files is *.KY2. 

Previewing and Printing a Keypad Report 

The RAC6182 Keypad Configuration Utility creates a printed report for 
each Keypad Configuration.  You can print the report or preview the 
report first and then print it.  Print Preview is a convenient way to view 
the keypad configuration. 

To preview a keypad configuration: 
1. Open the *.KY2 keypad configuration file you want to preview. 

2. Choose Print Preview from the File menu. 

The Preview workspace opens showing the keypad report.  The 
report includes: 

• Keypad configuration file name *.KY2, or “RAC6182 Keypad 
Configuration” if the keypad configuration is from the RAC6182. 

• Date/time report generated. 

• Description field of the keypad configuration. 

• List of Non-programmable keys (enabled or disabled) on Page 1. 

• Definitions of programmable keys (enabled or disabled), and 
whether the key definition is Macro/String, Make/Break 
Typematic or Run Program on Page 2. 

Macro/String definitions appear in double quotes; e.g. “String”.  
Make/Break Typematic definitions appear in single quotes; e.g. ‘a’.  
Run Program definitions appear within braces; e.g. {Program 
Name}.  Disabled keys appear with a line through the key name and 
definition. 
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Figure 16 
Print Preview 
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3. Select one of the buttons at the top of the workspace. 

Click this button: To: 

Print  Open a Print dialog allowing you to print the report.  
See the next page. 

Zoom In Increase the magnification of the view so the report 
looks larger.  You can increase the magnification 
several times. 

Zoom Out Decrease the magnification of the view so the report 
looks smaller.  You can decrease the magnification 
several times. 

Close  Exit the Preview workspace. 
 

Downloading a Keypad Configuration to the RAC6182 

To download a keypad configuration to the RAC6182: 
1. The active window must contain the keypad configuration you want 

to download to the RAC6182. 

2. From the File menu, choose Download Keypad configuration to 
RAC6182….  A dialog opens asking you if you want to replace the 
current contents of the RAC6182 with the contents of the active 
window. 

 

Figure 17 
Download 

3. Click OK to continue with the download. 
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7.7 in. Keypad Default Key Assignments  
for Programmable Keys 
RA=Right Alt Key, RS = Right Shift Key, VK = Virtual Key 

Key Legend Default Key 
Assignments 

Make Key Codes 
(Key Pressed) 

Break Key Codes 
(Key Released) 

F1 VK_F1 0x70 0x70 

F2 VK_F2 0x71 0x71 

F3 VK_F3 0x72 0x72 

F4 VK_F4 0x73 0x73 

F5 VK_F5 0x74 0x74 

F6 VK_F6 0x75 0x75 

F7 VK_F7 0x76 0x76 

F8 VK_F8 0x77 0x77 

F9 VK_F9 0x78 0x78 

F10 VK_F10 0x79 0x79 

F11 VK_F11 0x7a 0x7a 

K1 RA + VK_F1 0x12, 0x70 0x12, 0x70 

K2 RA + VK_F2 0x12, 0x71 0x12, 0x71 

K3 RA + VK_F3 0x12, 0x72 0x12, 0x72 

K4 RA + VK_F4 0x12, 0x73 0x12, 0x73 

K5 RA + VK_F5 0x12, 0x74 0x12, 0x74 

K6 RA + VK_F6 0x12, 0x75 0x12, 0x75 

K7 RA + VK_F7 0x12, 0x76 0x12, 0x76 

K8 RA + VK_F8 0x12, 0x77 0x12, 0x77 

K9 RA + VK_F9 0x12, 0x78 0x12, 0x78 

K10 RA + VK_F10 0x12, 0x79 0x12, 0x79 

K11 RA + VK_F11 0x12, 0x7a 0x12, 0x7a 

K12 RA + VK_F12 0x12, 0x7b 0x12, 0x7b 

K13 RS + VK_F1 0x10, 0x70 0x10, 0x70 

K14 RS + VK_F2 0x10, 0x71 0x10, 0x71 

K15 RS + VK_F3 0x10, 0x72 0x10, 0x72 

K16 RS + VK_F4 0x10, 0x73 0x10, 0x73 
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12.1 in. Keypad Default Key Assignments  
for Programmable Keys 
RA=Right Alt Key, RS = Right Shift Key, VK = Virtual Key 

Key Legend Default Key 
Assignments 

Make Key Codes 
(Key Pressed) 

Break Key Codes 
(Key Released) 

F1 VK_F1 0x70 0x70 
F2 VK_F2 0x71 0x71 
F3 VK_F3 0x72 0x72 
F4 VK_F4 0x73 0x73 
F5 VK_F5 0x74 0x74 
F6 VK_F6 0x75 0x75 
F7 VK_F7 0x76 0x76 
F8 VK_F8 0x77 0x77 
F9 VK_F9 0x78 0x78 
F10 VK_F10 0x79 0x79 
F11 VK_F11 0x7a 0x7a 
F12 VK_F12 0x7b 0x7b 
F13 LS + VK_F1 0x10, 0x70 0x10, 0x70 
F14 LS + VK_F2 0x10, 0x71 0x10, 0x71 
K1 RA + VK_F1 0x12, 0x70 0x12, 0x70 
K2 RA + VK_F2 0x12, 0x71 0x12, 0x71 
K3 RA + VK_F3 0x12, 0x72 0x12, 0x72 
K4 RA + VK_F4 0x12, 0x73 0x12, 0x73 
K5 RA + VK_F5 0x12, 0x74 0x12, 0x74 
K6 RA + VK_F6 0x12, 0x75 0x12, 0x75 
K7 RA + VK_F7 0x12, 0x76 0x12, 0x76 
K8 RA + VK_F8 0x12, 0x77 0x12, 0x77 
K9 RA + VK_F9 0x12, 0x78 0x12, 0x78 
K10 RA + VK_F10 0x12, 0x79 0x12, 0x79 
K11 RA + VK_F11 0x12, 0x7a 0x12, 0x7a 
K12 RA + VK_F12 0x12, 0x7b 0x12, 0x7b 
K13 RS + VK_F1 0x10, 0x70 0x10, 0x70 
K14 RS + VK_F2 0x10, 0x71 0x10, 0x71 
K15 RS + VK_F3 0x10, 0x72 0x10, 0x72 
K16 RS + VK_F4 0x10, 0x73 0x10, 0x73 
K17 RS + VK_F5 0x10, 0x74 0x10, 0x74 
K18 RS + VK_F6 0x10, 0x75 0x10, 0x75 
K19 RS + VK_F7 0x10, 0x76 0x10, 0x76 
K20 RS + VK_F8 0x10, 0x77 0x10, 0x77 
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Display Settings 

This chapter describes how to use the RAC6182 Display application to 
control the appearance of the Desktop and application windows in 
Windows CE, and to adjust the display. 

You configure the RAC6182 Industrial Computer display using the 
Display application in the Windows CE Control Panel. 

To set up the display:  
1. To start the Display application, select Start-Settings-Control Panel.  

Select or double-click on the Display icon. 

 

 

Chapter 9 

Chapter Objectives 

Setting Up the Display  
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2. On the Background tab of the Display Properties dialog, select a 
graphic to be displayed on the Windows CE Desktop. 

 

3. On the Appearance tab, change the color scheme used for 
Windows CE. 

 

4. On the Backlight tab, specify the length of time after which the 
RAC6182 Industrial Computer turns off the backlight when it is not 
needed. 
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5. On the CRT Video Mode tab, specify the video resolution and 
refresh rate for an external monitor connected to the RAC6182 
Industrial Computer. For versions of the RAC6182 with an integral 
display, the external video is fixed to the resolution on the internal 
LCD panel.   
 
For the non-display RAC6182, the resolutions can be selected.  They 
include: 

  640x480 VGA 

  800x600 SVGA 

  1024x768 XVGA 

 

6. On the Flat Panel tab, adjust the contrast level and brightness level of 
the flat panel display on RAC6182 Industrial Computer, if applicable 
to this unit.  

 

7. Press Enter or click the OK button to save the settings and exit. 
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Touchscreen Calibration 

This chapter describes how to use the RAC6182 Touchscreen application 
to calibrate the RAC6182 Industrial Computer touchscreen.  

The RAC6182 touchscreen is factory-calibrated.  However, it may be 
necessary to periodically recalibrate the touchscreen to adjust for any 
drift in the pointer.  To recalibrate the touchscreen, you touch targets 
displayed by the calibration.   

Touching the display with a finger is sufficient to perform the calibration 
process; however, you can use a stylus to increase the accuracy of the 
calibration.  Do not use a sharp instrument or any pointing device that 
may puncture or damage the RAC6182 touchscreen overlay material. 

You calibrate and configure the touchscreen using the Touchscreen 
application in the Windows CE Control Panel. 

To calibrate the touchscreen:  
1. To set up the touchscreen, select Start-Settings-Control Panel.  Select 

or double-click on the Touch Screen icon. 
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2. On the Calibration tab, select the Recalibrate button and touch the 
screen in the target areas as prompted by the application.   

 

3. Press Enter or click the OK button to save the settings and Exit. 
 

To set the double-tap (double-click) settings: 
When using a touchscreen, you may be required to "double-tap" the 
touchscreen to respond to the application. The Touchscreen application 
allows you to adjust the rate at which the screen must be tapped to 
perform a double-tap.  

1. On the Double-Tap tab, tap twice quickly on the grid pattern on the 
window to perform a double-tap. 

 

2. Double-tap the second icon to test the double-tap speed and 
accuracy. 

3. Press Enter or click the OK button to save the settings and Exit. 
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To disable the mouse cursor:  
On RAC6182 Industrial Computers with a touchscreen, you may want to 
disable the mouse and remove the mouse cursor from the screen. You can 
use either the Touchscreen application or the Control Panel Mouse 
application to change this setting.  

1. On the Cursor tab, clear the Enable Cursor checkbox to disable the 
mouse and remove the mouse cursor.   

 

2. Press Enter or click the OK button to save the settings and Exit. 

You must turn off power to the RAC6182 Industrial Computer for 
this setting to take effect. 
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Hardware Monitor 

This chapter describes how to use the RAC6182 Hardware Monitor 
application to do the following: 

• Monitor the internal bus voltages and temperature 

• Reset the Diagnostics LED 

• View the Event Log. 

 
The RAC6182 Hardware Monitor consists of a system software 
application and a Control Panel user interface.  The Hardware Monitor 
system software continuously monitors the RAC6182 computer’s 
internal 3.3V, 5V, and 12V power supply voltages, the 3V battery 
voltage, and CPU board temperature.   

If any of these diagnostic parameters exceed their preset limits, the 
Hardware Monitor will enter a time-stamped record of the event into the 
Event Log file.  It will also turn on the front bezel Diagnostics LED, 
indicating that a warning event has occurred.  The Diagnostics LED will 
remain lit until manually reset using the Hardware Monitor Control 
Panel interface, even if the parameter returns to normal limits.  There is a 
500msec delay period between a warning event and its being recognized, 
to "debounce" any boundary conditions and avoid spurious warnings 
from being logged. 

Enabling the Hardware Monitor 

When shipped from the factory, the RAC6182 Hardware Monitor system 
software is located at \Storage Card\Platform\HWMonitor.exe. A shortcut 
to HWMonitor.exe is also loaded into the \Storage 
Card\Windows\StartUp folder.  The RAC6182 Computer is shipped with 
the Hardware Monitor disabled.  Use the Hardware Monitor Control 
Panel interface to enable the Hardware Monitor.  Once enabled, as long 
as the shortcut is in \Storage Card\Windows\StartUp folder, the 
Hardware Monitor will automatically start and run in the background 
every time the RAC6182 Computer powers up. 

The first time the Hardware Monitor is enabled, it will create the Event 
Log file.  This file is \Storage Card\Platform\HWMonitorEvent.Log, and 
will remain persistent through future disables and enables of the 
Hardware Monitor, unless manually cleared using the Hardware Monitor 
Control Panel interface.  All diagnostic events are time-stamped and 
recorded in the Event Log file.  The Event Log file contents can be 
viewed using the Hardware Monitor Control Panel interface. 

Chapter 11 
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You access the RAC6182 Hardware Monitor using the Hardware 
Monitor interface in the Windows CE Control Panel. 

To access the RAC6182 Hardware Monitor: 
1. To open the Hardware Monitor interface, select Start-Settings-

Control Panel.  Select or double-click on the Hardware Monitor 
icon. 

 

2. Select the Voltage and Temp tab to view the RAC6182 internal bus 
voltages, internal battery voltage (battery is for the clock/calendar 
and 128KB battery-backed SRAM), and the internal temperature.   

 

The voltage and temperature readings are updated in real time.  The 
status icon next to each value is green if that parameter is within its 
limits, and red if the parameter is outside the preset limits.  If outside 
of their preset ranges, then the red Diagnostics LED on the front 
bezel is also lit and will remain lit until reset manually. 

Using the Hardware 
Monitor 
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Note: The temperature is measured on the CPU board, so it 
will be higher than the RAC6182 ambient operating 
temperature.  The RAC6182 operating temperature 
rating is specified as ambient temperature outside the 
RAC6182 chassis, and internal temperature limits are 
set to compensate for expected heat-rise inside the 
chassis. 

 
3. Select the Hardware Monitor tab to enable or disable the RAC6182 

Hardware Monitor system software. Start the Hardware Monitor 
system software by clicking on the box to Enable, and clicking OK.   

 

When enabled, the Hardware Monitor application automatically 
starts on power-up, as long as the shortcut remains in the \Storage 
Card\Windows\StartUp folder. 

The Clear Fault LED button is used to turn off the front bezel 
Diagnostics LED.  If any event occurs to turn on this LED, the LED 
remains lit even if the operating conditions return to normal. 

The RAC6182 last shutdown/boot reason is listed on the bottom of 
this window. 

4. Select the Event Log tab to view the Hardware Monitor’s Event Log.  
All time-stamped diagnostic events, such as an over-temperature, 
under-voltage, or low-battery condition, are recorded in the Event 
Log.  The Event Log is persistent through power cycles.  You can 
also clear the event log by pressing the Clear Events button. 
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Watchdog Timer  

This chapter describes how to use the RAC6182 watchdog timer to 
automatically reset the RAC6182 Computer in case of system lockup. 

The RAC6182 Industrial Computer has a built-in hardware timer that can 
be used to detect if the computer's processor locks up. To accomplish 
this, a software application is setup to restart the watchdog timer at 
regular intervals.  If the system locks up, the application cannot restart 
the external watchdog timer, and the timer circuitry enters time-out mode 
and automatically resets the RAC6182 Industrial Computer. 

Simple Watchdog Implementation 

The RAC6182 watchdog timer system software is a simple watchdog 
implementation, protecting against a catastrophic system lockup.   

The RAC6182 watchdog timer application runs as a normal priority task 
in Windows CE. This application will continue to run in the background 
and restart the watchdog timer unless: 

• The operating system itself locks up  

• A higher priority task locks up (by entering infinite loop or having a 
memory error)  

With a simple implementation, it is possible for an application with a low 
priority to lock up, or for two applications to reach deadlock without the 
watchdog timer being reset. 

Watchdog Control for Critical Applications 

A critical control application or multitasking application may need to 
control the RAC6182 watchdog timer circuitry directly, to protect against 
system lockup.  Software designers can utilize the watchdog API in their 
applications to restart the watchdog timer, instead of using the watchdog 
timer system software application. 

If you integrate watchdog functionality in your application, do not enable 
the watchdog timer system software application provided with the 
RAC6182. Otherwise, the system software application may continue to 
restart the timer when your application is locked up. 

Note also, that a watchdog timer only provides protection against system 
lockups.  You may also need to consider other types of protection, such 
as a checksum, when designing critical applications. 

Chapter 12 
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The RAC6182 watchdog feature consists of a system software 
application and a Control Panel user interface.  

Setting the Watchdog Interval 

The watchdog application allows you to specify the amount of time that 
can elapse before the system is reset.  The watchdog interval can be set 
in 0.1 second increments from 0.5 to 4.0 seconds.  The shorter the 
interval, the faster the RAC6182 Industrial Computer will be reset.  

Choose the watchdog interval carefully. The Watchdog Timer application 
will consume more of the Windows CE operating system bandwidth to 
restart the watchdog timer if it is set to short intervals. 

Enabling the Watchdog Timer 

When shipped from the factory, the watchdog timer system software 
application is disabled on the RAC6182 Industrial Computer.  The 
watchdog timer application file is located at \Storage 
Card\Platform\Watchdog.exe.  

A shortcut to Watchdog.exe is also loaded into the \Storage 
Card\Windows\StartUp folder. Once you enable the application, the 
shortcut starts the watchdog timer application when the RAC6182 
Computer powers up.  

To enable the watchdog timer: 
1. To enable the watchdog timer, select Start-Settings-Control Panel.  

Select or double-click on the Watchdog icon. 

 

Using the Watchdog 
Timer System Software 
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2. Select the Enable checkbox to turn on the watchdog timer software. 

3. Select the desired watchdog timer interval using the slider control 
arrows.  The interval can be from 0.5 to 4.0 seconds, in 0.1-second 
increments. 

 

4. Press Enter or click the OK button to save the settings and exit. 

The watchdog timer application automatically starts the next time 
you power-up the computer, as long as the shortcut remains in the 
\Storage Card\Windows\StartUp folder. 
 

To disable the watchdog timer: 
1. To disable the watchdog timer, select Start-Settings-Control Panel.  

Select or double-click on the Watchdog icon. 

2. On the Watchdog Properties dialog box, clear the Enable check box.   

3. Restart the RAC6182 Industrial Computer, and the watchdog timer 
application is disabled.
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Communications Configuration 

This chapter describes how to configure the RAC6182 Industrial 
Computer to communicate with other computers using either the 
Ethernet connection or the serial connection. This chapter’s topics 
include: 

• Setting up Ethernet communications 

• Setting up serial communications 

 

Setting up the RAC6182 Industrial Computer to communicate over an 
Ethernet network consists of two steps: 

• Setting up the Ethernet configuration 

• Setting up the RAC6182 Industrial Computer communications to use 
the Ethernet configuration  

Network Configuration 

You configure communication over the Ethernet port using the Network 
application in the Windows CE Control Panel. 
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To set up network configuration:  
1. To set up the network configuration, select Start-Settings-Control 

Panel.  Select or double-click on the Network icon. 

 

 
2. On the Adapters tab, select Intel 8255x Ethernet Chip from the list 

and select the Properties button. 
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3. Complete the information on the IP Address and Name Server tabs 
as necessary for your Ethernet network. 

 

4. Press Enter or click the OK button to save the network settings and 
Exit. 
 



13–4 Communications Configuration 

 

Publication 6182-UM001D-EN-P 

Communications Configuration for Ethernet 

Once you have configured the Ethernet settings for your network, you 
must set the communications option for the RAC6182 to use the Ethernet 
connection and you must identify the host PC.  

Note: To complete this process, you must know the IP address and 
host name that identifies the host PC on the network. 

 
To set up communications configuration for Ethernet:  
1. To set up RAC6182 host communications, select Start-Settings-

Control Panel.  Select or double-click on the Communications icon. 

 

 
2. On the Device Name tab, enter the Device Name for the RAC6182 

Industrial Computer. Optionally enter a description in the Device 
Description field.  This information is used to identify the RAC6182 
Industrial Computer to the host PC. 
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3. On the PC Connection tab, select the Change button. 

 

4. On the PC Connection Parameters dialog, specify the network host 
name for the host PC in the Connect PC Name field and specify the 
IP address for the host PC in the Connect PC IP Addr field. 

5. Select Network Connection in the Connection Method field to 
specify that the RAC6182 should use the Ethernet network settings 
to connect to the host PC. 

6. Press Enter or click the OK button on the PC Connection Parameters 
dialog to save the settings and Exit. 

7. Press Enter or click the OK button on the Communications 
Properties dialog to save the settings and Exit. 

For information on connecting to the host PC, refer to Chapter 15, 
Managing User Applications. 
 

Setting up the RAC6182 Industrial Computer to communicate over a 
serial port consists of two steps: 

• Creating a remote networking connection for the serial port 

• Setting up the RAC6182 Industrial Computer communications to use 
serial communications  

Setting Up Serial 
Communications  
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Remote Networking Connection  

If you need to connect the RAC6182 Industrial Computer directly to a 
host PC using the serial port, you must first set up a remote networking 
connection.   

To set up a remote networking connection for serial communications: 
1. Select Start-Programs-Communication-Remote Networking.   

2. Select the Make New Connection icon. 

3. Enter a name for the connection in the Name field and select the 
connection type. For serial connection to a host PC, select Direct 
Connection.   

4. Select the device to use for this connection.  For serial connection to 
a host PC, select Serial Cable on COM2.   

5. Select Configure to set up the new connection.  Specify the 
following information and select OK: 

Field Value 

Baud Rate Select desired baud rate 

Data Bits 8 

Parity None 

Stop Bits 1 

Flow Control Hardware 
 

6. Select Finish. 

Remote Networking creates the new connection. 

Communications Configuration for Serial Communications 

Once you set up remote networking on the RAC6182 Industrial 
Computer, you must configure the RAC6182 to use your remote 
networking connection.  You set up serial communications using the 
Communications application in the Windows CE Control Panel. 

To set up communications configuration for serial communications: 
1. To set up RAC6182 host communications using serial 

communications, select Start-Settings-Control Panel.  Select or 
double-click on the Communications icon. 

2. On the Device Name tab, enter the Device Name for the RAC6182 
Industrial Computer. Optionally enter a description in the Device 
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Description field.  This information is used to identify the RAC6182 
Industrial Computer to the host PC. 

3. On the PC Connection tab, select the Change button. 

4. Select the name of the remote networking connection you created 
previously in the Connection Method field.  You do not need to 
specify a name or IP address on this tab. 

5. Press Enter or click the OK button to save the communications 
settings and Exit. 

For information on connecting to the host PC, refer to Chapter 15, 
Managing User Applications. 
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Managing User Applications 

This chapter describes how to set up a desktop computer to connect the 
RAC6182 Industrial Computer, how to transfer files between the 
computers, and how to manage user applications and data on the 
RAC6182 Computer.  This chapter’s topics include: 

• Installing and using Microsoft ActiveSync on the host computer 

• Installing and removing RAC6182 Computer applications 

• Transferring files to and from the RAC6182 Computer 

• Upgrading the RAC6182 Windows CE operating system 

Before you can set up the host computer, you must connect the 
RAC6182 Industrial Computer to the host computer or network, and you 
must set up the communications configuration.  For more information, 
refer to Chapter 3, Connecting External Devices, and to Chapter 13, 
Communications Configuration. 

Microsoft ActiveSync can be installed from the RAC6182 Applications 
and Accessories CD-ROM shipped with every RAC6182 Industrial 
Computer.  ActiveSync is used to exchange data between a desktop PC 
and the RAC6182 Industrial Computer.   

ActiveSync Installation 

Microsoft ActiveSync works with the following Microsoft operating 
systems: Windows 95, Windows 98, Windows NT, and Windows 2000.  
For detailed information on ActiveSync features, read the ActiveSync 
Help information once the program is installed. 

To install Microsoft ActiveSync on a desktop PC: 
1. Connect the RAC6182 Industrial Computer to a desktop PC serial 

port using a null modem cable (6189-2NMCBL). 

Note: To complete the ActiveSync installation on a PC, you 
must connect the RAC6182 to the host PC using serial 
communications.  Use a null modem cable attached to 
the COM2 port on the RAC6182.  
After you install ActiveSync on the host PC, you can 
use either a serial communications or Ethernet 
communications to communicate with the RAC6182. 

 
2. Apply power to both the host PC and the RAC6182 Industrial 

Computer. 

Chapter 14 
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3. Insert the RAC6182 Applications and Accessories compact disc into 
the desktop PC CD-ROM drive. 

4. Open the ActiveSync 3.0 folder on the CD-ROM and run the Setup 
application. 

5. Follow the prompted messages displayed by the Microsoft 
ActiveSync Setup wizard.  The wizard installs Microsoft 
ActiveSync, any required Windows components, and other optional 
applications for running a hand-held PC.  

6. At the end of its installation process, Microsoft ActiveSync attempts 
to create a connection using the Get Connected wizard. The 
RAC6182 Industrial Computer must be connected and powered up 
for the connection wizard to work correctly.  It automatically 
searches for any mobile devices connected to a serial or IR port.   
 
While ActiveSync is searching for a connection, initiate the serial 
connection on the RAC6182 by running PC Link. It may take several 
attempts for PC Link and ActiveSync to establish a connection. 

Note: For instructions on setting up communications, refer to 
“Setting Up Serial Communications” on page 13-5. 

 
Important: To work properly, ActiveSync must make its first 

connection to an external device (immediately following 
installation) via a serial port.  Once this connection is made, 
ActiveSync can connect to any external device via Ethernet. 

 
To create a connection between Microsoft ActiveSync and the RAC6182: 
If the wizard does not successfully create the connection, do the 
following: 

1. Start ActiveSync on the host PC and follow the on-screen 
instructions until the Verify COM Port Availability window is 
displayed. 

2. Check that the COM port is available. Select Next to try another 
search for a mobile device on a serial port. 

3. Ensure that the serial cable is connected between the COM2 port and 
the desktop PC serial port.  

Note: You must use the COM2 port on the RAC6182 to 
connect to ActiveSync using serial communications, 
and you must set up the PC connection on the 
RAC6182 with the COM2 direct connection. 

 
4. On the RAC6182 Industrial Computer, select Start-Programs-

Communication-PC Link. 
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PC Link attempts to establish a connection with the host computer 
using the connection method you set up.  

5. ActiveSync starts the Get Connected wizard.  Follow the wizard 
prompts to establish a connection with the RAC6182 Industrial 
Computer. 

6. Once a connection is established, do not create a partnership 
between the PC and the RAC6182.  Instead, initiate subsequent 
connections from the RAC6182 by selecting Start-Programs-
Communication-PC Link. 

Additional Help on Microsoft ActiveSync 

To get additional information on how to use Microsoft ActiveSync, see 
the online Help by selecting Microsoft ActiveSync Help from the Help 
menu. Help topics are available for set-up, usage, and troubleshooting 
information. 
 

There are at least three methods for installing a software application on 
the RAC6182 Industrial Computer.  Each software application has its 
own defined installation process, so you should follow the installation 
instructions shipped with the software application. 

 
• ActiveSync can be used to transfer a software application file from the 

desktop PC to the RAC6182 Industrial Computer.  Once loaded, the 
application file can then be run on the RAC6182 Industrial Computer 
to install and register it with the RAC6182 Windows CE operating 
system. 

• A flash memory card can be used to transfer a software application 
file into the RAC6182 Industrial Computer DOC flash memory (the 
\Storage Card folder on the RAC6182).  Install the flash memory 
card in the RAC6182 PC card slot, and then open the flash card 
window (\Storage Card2 or \Storage Card3).  Copy the file into the 
DOC flash memory using Windows Explorer.  Once transferred, the 
application file can be run to install and register the application with 
the Windows CE operating system. 

Note: To install an application permanently into memory, you 
must ensure that the application is installed to the 
\Storage Card folder.  Applications installed into the 
\Program Files folder are lost when power is cycled. 

 
• The software application may provide a desktop PC program that 

automatically uses the ActiveSync connection to download and 
register the application to the RAC6182 Industrial Computer. 

Installing/Removing 
Applications on the 
RAC6182 Industrial 
Computer 
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Removing Applications 

Most Windows CE applications loaded on the RAC6182 Industrial 
Computer should have an uninstall utility.  Use the program’s 
uninstall routine to remove it from the RAC6182.  Failure to 
properly uninstall an application program may affect the Windows 
CE registry and cause unstable operation. 

There are at least three methods to transfer files to and from the 
RAC6182 Industrial Computer. 

 
• ActiveSync can be used to move files between the desktop PC and 

the RAC6182 Industrial Computer.  The files can be manually 
dragged between the PC and the RAC6182 Mobile Devices folder or 
its subfolders. 

• Some software applications may have proprietary file transfer 
features.  An application may support file transfers of the RAC6182 
serial or network ports.  Refer to the application’s user manual for 
more information. 

• A flash memory card can be used to manually transfer files to and 
from the RAC6182 Industrial Computer.  When installed, a flash 
memory card appears as a separate "drive" within the Windows CE 
operating system environment.  Files can be copied and moved 
between the flash memory card and the RAC6182 DOC flash 
memory. 

 
The RAC6182 Industrial Computer is shipped with the Microsoft 
Windows CE operating system preinstalled in the DOC flash memory. 

Rockwell Automation will periodically distribute the RAC6182 
Industrial Computer operating system upgrades as new features are 
released.  These upgrades are distributed on CD-ROM.  Upgrade 
procedures are on the CD-ROM.  

Carefully read all documentation shipped with the RAC6182 Industrial 
Computer operating system upgrade.  This documentation will outline 
any differences in the upgrade, and how installed application software 
may be affected by the new Windows CE version.  It is very important to 
make sure all installed RAC6182 Industrial Computer applications are 
compatible with the new operating system. 

Transferring Files To and 
from the RAC6182 
Industrial Computer 

Upgrading the RAC6182 
Windows CE Operating 
System 



 

 

System Troubleshooting 

This chapter describes the most common operating problems, the 
probable causes, and recommended corrective actions including: 

• troubleshooting procedure 

• troubleshooting checklists 

• power on self test (POST) error messages 

• general error and information messages 

• resetting the Windows CE registry 
 

The RAC6182 Industrial Computer monitors internal system voltages 
and the internal product temperature.  If either of these diagnostic 
parameters fall out of tolerance, the red Diagnostics LED indicator on 
the front bezel is turned on.   

Use the Hardware Monitor application to view diagnostic information 
and reset the Diagnostics LED.  For more information, refer to Chapter 
12, Hardware Monitor. 

To help identify and isolate a problem, we recommend that you do the 
following when a problem occurs: 

1. Turn off the power to the RAC6182 Industrial Computer. 

2. Disconnect all peripheral devices and remove all add-in PC and PCI 
cards. 

3. Connect an external PS/2 keyboard and PS/2 mouse (if used) to the 
side panel connectors. 

4. Check the video connections if using an external monitor. 

5. Apply power and observe the LEDs on the front panel (if present).  
Make sure the power on indicator is illuminated. 

6. Monitor the Power On Self Test (POST).  One of the following will 
occur: 

  The RAC6182 Industrial Computer will successfully complete 
the boot-up process and start Windows CE. 

  The boot-up process will terminate (fatal error). 

Chapter 15 
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7. If the system boots up, isolate the problem by connecting peripheral 
devices one at a time until the problem occurs.  If the problem is 
with a specific software package or driver, you may want to re-install 
the software. 

8. If there is a problem not related specifically to a software installation 
or peripheral device, refer to the following troubleshooting 
checklists. 
 

The following are checklists of items that you may have overlooked. 

If you are having problems during boot-up: 
  Are all connections secure? 

  Are the device drivers installed?  

  Are the jumpers on any add-in boards correctly positioned? 

  Is the RAM memory (DIMM) properly installed?  You may want to 
re-install it to ensure a good connection. 

  Has the Windows CE operating system been upgraded?  If so, make 
sure the procedure was successfully performed (refer to Chapter 15, 
Managing User Applications). 

If there is a problem after boot-up: 
  If you are running a software package, re-install the software. 

  If the problem is intermittent, you may have a loose connection.  
Check all connections including any add-in cards.  Check that the 
memory module (DIMM) is fully installed. 

  Although the RAC6182 Industrial Computer has a regulated and 
protected power supply, a transient voltage in the power line or 
peripheral cable may cause a flickering display, unexpected reboots, 
or a locked up system.  If so, exit the application and start over. 

Troubleshooting  
Check Lists 
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  Is the system overheating?  Look at the diagnostics light on the front 
panel display (if present).  Verify that the enclosure is properly 
ventilated so the RAC6182 ambient operating temperature is within 
specifications. 

If there is a problem running new software: 
  Does the software have a hardware requirement that is not present? 

  Are you using an authorized copy of the software?  Some copies of 
software will not work without proper activation. 

  Did the software install correctly?  Re-install the software. 

  Are you following the software's instructions?  Refer to the software 
vendor’s user manual. 

If there is a problem with an add-in board: 
  Is the board installed and configured correctly?  Recheck jumper and 

other configuration settings. 

  Are any cables correctly installed? 

  Are the Windows CE drivers loaded for the add-in board? 

If incorrect characters are displayed or are distorted: 
  Are the display contrast and brightness controls properly adjusted? 

For information on configuring display settings, refer to Chapter 10, 
Display Settings. 

  Is the monitor compatible with the selected video mode?  The 7.7-in. 
RAC6182 Industrial Computer LCD display is 640x480 (VGA) 
resolution. The 12.1-in. display is 800x600 (SVGA) resolution.   

  If using the integrated display, open the RAC6182 chassis and check 
the cable connections between the computer chassis and front bezel 
assembly. 

If characters are not displayed on an external monitor:  
  Is the monitor functioning properly?  

  Is the video cable properly installed? 

  Check that selected character color is not set the same as the 
background color. 
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  Is the video driver properly installed? 

  Reboot the RAC6182 Industrial Computer with the external monitor 
connected and powered up. 

If the Power On LED indicator does not come on: 
  Check the power supply connections and front bezel cable 

connections on the processor board. 

  Check the power connections. 

 
The RAC6182 is capable of resetting the Windows CE registry to the 
factory default.  This may be required if an application damages the 
registry information and the RAC6182 will no longer boot.   

Jumper J2 on the RAC6182 CPU board is used to boot the RAC6182 
Industrial Computer into debug mode, which will load the factory-
default Windows CE registry. 

 

 
To change the J2 jumper: 
1. Disconnect power from the RAC6182 Computer. 

2. Disconnect any device connected to COM2 port. 

3. Follow the procedures on Page 4-2 to open the computer chassis. 

Resetting the Windows 
CE Registry 
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4. Locate jumper J2.  The 2-pin jumper should be across pins 2 and 3 
for normal operation. 

5. Change the 2-pin jumper to connect pins 1 and 2. 

6. Follow the procedures on Page 4-3 to close the computer chassis. 

To reset the Windows CE registry: 
1. Apply power to the RAC6182 Computer.   

The computer boots into a debug mode.  This mode performs a more 
extensive power-on self test (POST) procedure.  It also reverts to the 
factory stored Windows CE registry.  Finally, it enables a debug 
monitor output on COM2.  The debug monitor is a Windows CE 
development tool feature for product development or debug purposes 
only. 

2. After the RAC6182 Computer boots in debug mode, delete the 
previous registry files.  Open Windows Explorer from Start-
Programs-Windows Explorer or double-click the My Computer 
desktop icon.   

3. Open the \Storage Card folder.  From the View menu, select Options.  
Make sure the option is set to show all files. 

4. Delete the following two files from \Storage Card folder: 

  Regbak.rlz 

  Registry.rlz 

5. Disconnect power from the RAC6182 computer. 

6. Follow the procedures on Page 4-2 to open the computer chassis. 

7. Change the 2-pin jumper J2 back to connect pins 1 and 2 to restore 
normal operation. 

8. Follow the procedures on Page 4-3 to close the computer chassis. 

9. On the next power-up, the RAC6182 Computer boots in normal 
mode and uses the factory default registry information, stored in the 
boot block flash memory.   

The Regbak.rlz and Registry.rlz files will be recreated when an item 
is changed that affects the registry, such as a Control Panel setting or 
installation of an application program.  Otherwise, the RAC6182 
continues to use the factory default registry information. 
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Maintenance 

This chapter describes routine maintenance procedures for: 

• cleaning the display and front bezel 

• replacing the battery 

Note: Procedures for replacing the RAC6182 Industrial Computer 
backlight are in Chapter 5, Installing/Removing Front Bezel 
Assembly Items. 

 
To clean the display: 

 

ATTENTION: Use of abrasive cleansers or solvents may 
damage the display window.  Do not scrub or use brushes. 

 
1. Disconnect power from the RAC6182 Industrial Computer at the 

power source. 

2. Using a clean sponge or a soft cloth, clean the display with a mild 
soap or detergent. 

3. Dry the display with a chamois or moist cellulose sponge to avoid 
water spots. 

 

ATTENTION: If the RAC6182 Industrial Computer has 
a touchscreen, be aware that it is possible for screen 
objects to activate during equipment wash-downs. 

 
 

To remove paint and grease: 
Remove fresh paint splashes and grease before drying by rubbing lightly 
with isopropyl alcohol.  Afterward, provide a final wash using mild soap 
or detergent solution.  Rinse with clean water. 

 

ATTENTION: Make sure the isopropyl alcohol does not 
come in contact with the equipment labels. 

Alcohol may cause the label printing to smear. 
 

Chapter 16 

Chapter Objectives 

Cleaning the Display 
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The RAC6182 Industrial Computer contains a battery to maintain the 
CMOS SRAM and real-time clock.  The battery is located in a battery 
holder on the RAC6182 Industrial Computer backplane.  Replace this 
battery as needed with a Panasonic battery, part number CR2032, or 
Allen-Bradley part 6189-1BATT. 

 

ATTENTION:  There is a danger of explosion if the 
battery is incorrectly replaced.  Replace only with the 
same or equivalent type recommended by the 
manufacturer.  Dispose of used batteries according to the 
manufacturer's instructions. 

 

The RAC6182 Industrial Computer contains a super-capacitor in parallel 
with the battery.  In the event that the battery dies, this capacitor will 
hold the RAM and clock for a minimum of 4 hours, up to a maximum of 
8 hours based on battery age and RAC6182 operation.  It also maintains 
the RAM and clock setting while the battery is removed and replaced.  
Power down the RAC6182 Industrial Computer before changing the 
battery. 

The battery life is dependent on the amount of on-time per week. 
Estimated life of the battery is listed below: 

On-Time Expected Battery Life 

0 hours/week 4 years 

40 hours/week 5.5 years 

80 hours/week 7 years 
 
 

If a complete system failure occurs, use the following procedures to 
restore the RAC6182 Industrial Computer to its factory configuration. 

1. Delete all files in the \Storage Card folder.  Make sure to delete all 
hidden files and folders. 

2. Use the instructions in Chapter 16, System Troubleshooting, to reset 
the RAC6182 Windows CE registry to its factory default. 

3. The RAC6182 operating system is stored in a protected segment on 
the DiskOnChip flash memory.  You should not need to reinstall the 
operating system.  However, if you feel it necessary, use the 
instructions in Chapter 15, Managing User Applications, to reload 
the RAC6182 Windows CE operating system. 

Replacing the Battery 

Restoring the RAC6182 
Industrial Computer 
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4. The RAC6182-specific files that need to be reloaded into the 

\Storage Card folder are distributed on the RAC6182 Applications 
and Accessories CD-ROM.  Create the necessary folders and copy 
the files to these folders.  See the RAC6182 Storage Card Folders 
section in Chapter 15, Managing User Applications. 

5. Power cycle the RAC6182 and verify that all RAC6182-specific 
Control Panel applications are loaded. 

6. Reload any application programs using the vendor-supplied backup 
files.  Make sure that these programs are compatible with the 
RAC6182 operating system version, especially if you have reloaded 
the Windows CE operating system. 
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Replacement Parts and 
Accessories 

This chapter describes the replacement parts and accessories that are 
available for the RAC6182 Industrial Computer, with their 
corresponding part numbers. 

 

Description Catalog Number 
Computer Chassis: 

AC Power Supply 6189-2ACPS 
Terminal block for AC power, DC power and 
diagnostics relay output 

6189-2CONN 

64MB DiskOnChip flash ROM 6189-2FL64 
64MB DIMM SDRAM 6189-DIMM64 
128MB DIMM SDRAM 6189-DIMM128 
256MB DIMM SDRAM 6189-1DIMM256 
32MB flash PC card (ATA) 6189-ATA32 
64MB flash PC card (ATA) 6189-ATA64 
Single-channel DH+/RIO/DH485 Network PCI 
Card 

1784-PKTX 

Cables: 
RS232 Null Modem Cable 6189-2NMCBL 

Software: 
RAC6182 Software Development Kit (Visual 
C++, Visual Basic) 

6189-SDK 

Windows CE 3.0 Upgrade 6189-2WINCE30 
 

Important: For a replacement chassis assembly, order the RAC6182 
non-display unit with the required options (6182-xAxxxx). 

 
 

Chapter 17 

Chapter Objective 

Replacement Parts 
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Description Catalog Number 
Front Bezel Assembly: 

7.7 in. Keypad front bezel assembly  6189-2LCDBZL8K 
7.7 in. Keypad & Touchscreen front bezel 
assembly  

6189-2LCDBZL8KT 

12.1 in. Keypad front bezel assembly  6189-2LCDBZL12K 
12.1 in. Keypad & Touchscreen front bezel 
assembly  

6189-2LCDBZL12KT 

12.1 in. Touchscreen front bezel assembly  6189-2LCDBZL12T 
7.7 in. Keypad plastic bezel & overlay 6189-2BZL8K 
7.7 in. Keypad & Touchscreen plastic bezel & 
overlay 

6189-2BZL8KT 

12.1 in. Keypad plastic bezel & overlay 6189-2BZL12K 
12.1 in. Keypad & Touchscreen plastic bezel & 
overlay 

6189-2BZL12KT 

12.1 in. Touchscreen plastic bezel & overlay 6189-2BZL12T 
7.7 in. and 12.1 in. bezel mounting clips (qty 4) 6189-2MTGKIT 
7.7 in. bezel legend strip kit (1 set of 3 strips) 6189-2KEYKIT8 
12.1 in. bezel legend strip kit (1 set of 3 strips) 6189-2KEYKIT12 
12.1 in. Antiglare overlay 6189-1AG121 

Input Devices: 
Mouse, panelmount 6189-HPMOUSEP 
Keyboard, desktop stainless steel with integral 
mouse 

6189-KBDEPS1 

Keyboard, panelmount stainless steel with 
integral mouse 

6189-KBPEPS1 

Keyboard, desktop plastic with integral mouse 6189-KBDEPU1 
Adapter Plates – 12.1 in. Display: 

To replace a PanelView 1200 keypad, 1400 
keypad, 1200e keypad, 1400e keypad 

2711-NR5K 

To replace a PanelView 1200 touch, 1200e 
touch 

2711-NR5T 

To replace a PanelView 1400 touch, 1400e 
touch 

2711-NR7T 

 

 



 

 

Specifications 

7.7 in. Display  
Type Dual Scan Color Super Twisted Numatic (STN) LCD 
Nominal Display Area 
     Horizontal 
     Vertical 

 
6.2 in (157 mm) 
4.6 in (118 mm) 

Viewing Angle 
     Horizontal (typical) 
     Vertical (typical) 

 
+/- 50 degrees 
+50/-30 degrees 

Resolution 640x480  (VGA) 
Response Time (typical) 270 msec rise, 80 msec decay  
Luminance (typical) 120 nit, 35 fL (overlay option will affect luminance) 
Contrast Ratio (typical) 50:1 
CIE coordinates: White  X=0.275 Y=0.330     
Backlight life 40,000 hours to half-brightness 
Touchscreen Rating Minimum 20 x 20 pixels touch cell 

1,000,000 presses 
Keypad Rating 3,000,000 presses 
12.1 in. Display  
Type Active Matrix Color Thin-Film-Transistor (TFT) LCD 
Nominal Display Area 
     Horizontal 
     Vertical 

 
9.7 in (246 mm) 
7.3 in (185 mm) 

Viewing Angle 
     Horizontal (typical) 
     Vertical (typical) 

 
+/- 60 degrees 
+55/-45 degrees 

Resolution 800x600  (SVGA), 256K (18 bit) colors 
Response Time 30 msec (typical) 
Luminance (typical) 250 nit, 73 fL (overlay option will affect luminance) 
Contrast Ratio (typical) 300:1 
CIE coordinates: White  X= 0.313 Y= 0.329    
Backlight life 50,000 hours to half-brightness 
Touchscreen  Rating Minimum 25 x 25 pixels  touch cell 

15,000,000+ presses 
Keypad Rating 3,000,000 presses 
Non-display 
Video Port HD15 video connector, analog 
Resolution 640x480 (VGA), 800x600 (SVGA), 1024x768 (XVGA) 

 

Appendix A 
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Mechanical  
Enclosure 
     Display versions 
 
     Non-display version 

 
NEMA 12, 13, 4X (indoor) when panel mounted.  
(IP65) 
NEMA 1 

LED Indicators 
     Display versions 
     Non-display version 

 
Two green and one red indicators on front bezel 
None 

Dimensions (overall) 
     7.7 in. with keypad 
 
     12.1 in. with keypad 
 
     12.1 in. with touchscreen 
 
     Non-display  

Height x Width x Depth  (bezel dimensions) 
223.6 mm x 321.5 mm x 75.4 mm 
8.80 in x 12.66 in x 2.97 in 
282.6 mm x 415.7 mm x 75.8 mm 
11.12 in x 16.36 in x 2.98 in 
282.6 mm x 363.3 mm x 75.8 mm 
11.12 in x 14.3 in x 2.98 in 
195.8 mm x 330.2 mm x 57.3 mm 
7.71 in x 13.00 in x 2.26 in 

Dimensions (panel cutout) 
     7.7 in. with keypad  
     12.1 in. with keypad  
     12.1 in. with touchscreen 

Rectangular cut-out – Height x Width 
     197.8 mm (7.79 in) H   x  295.8 mm (11.65 in) W 
     256.8 mm (10.11 in) H  x  389.9 mm (15.35 in) W 
     256.8 mm (10.11 in) H  x  337.6 mm (13.29 in) W 

Weight 
     7.7 in. with keypad  
     12.1 in. with keypad  
     12.1 in. with touchscreen  
     Non-display  

 
8.65 lbs (4.0 kg) 
11.65 lbs  (5.3 kg) 
11.15 lbs  (5.1 kg) 
6.65 lbs  (3.0 kg) 

Shipping Weight (approx.) 
     7.7 in. version 
     12.1 in. version 
     Non-display version 

 
15 lbs  (6.8 kg) 
20 lbs  (9.1 kg) 
13 lbs  (5.8 kg) 

 

Environmental  
Operating Temperature 0 C to 50 C 
Storage Temperature -25 C to 60 C 
Relative Humidity * 8% to 80% non-condensing 
Operating Altitude Sea level to 10,000 ft (3048m)  
Non-Operating Altitude Sea level to 40,000 ft (12000m) 
Operating Shock 15g (1/2 sine, 11 msec) 
Non-operating Shock 30g (1/2 sine, 11 msec) 
Operating Vibration 0.006in. p-p, 10-57Hz 

1.0G peak, 57-150Hz sine 
Non-operating Vibration 0.015 in. p-p, 10-57Hz 

2.5g peak, 57-150Hz sine 
 
* Applications with touchscreens in high-humidity and high-temperature environments have 
additional considerations. 
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Electrical (AC Option)  
Line Voltage 85 to 132VAC, 170 to 264VAC autoranging 
Line Frequency 47-63Hz 
Ground Leakage 1.0 uA max at 1.5KVDC 
Power Consumption 45/55VA (0.4A @ 120Vrms, 0.25A @ 240Vrms) 
Power Dissipation 16W typical (no add-in cards) 

24W maximum 

 

Electrical (DC Option)  
Line Voltage 18-32VDC 
Input Current 0.8A typical (no add-in cards) 

1.4A maximum 
Power Consumption 16W typical (no add-in cards) 

24W maximum 

 

Diagnostic Relay Output  
Relay rating 0-24V AC or DC.  Normally open 
Maximum current 0.5A at 24VDC. 

 

Agency Approvals 

 

 
 
UL 508 Listed UL/C-UL Industrial Control Equipment 

 

 
UL 1604 Listed UL/C-UL Industrial Flat Panel Monitor  

     
UL 1950 Recognized Component, 
C-UL 950 Recognized Component 

LVD (73/23/EEC) EN 60950  
  

 
EMC (89/336/EEC) 
 

 
EN 50081-2: 1993 
EN 55022: 1998 Class A 
EN 55024: 1998 
EN 61326: 1998 
EN 61000-3-2: 1995 
EN 61000-3-3: 1995 

 

 
 

                                                      

  Note:  With a 1784-PKTX communication module, the system does not meet 
CID2. 
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Processor Board Specifications  

The following table lists the RAC6182 Industrial Computer processor 
board specifications: 

Item Description 

Processor QED MIPS R4300 32-bit RISC processor, 225MHz 

Boot Code Version contained on ROM label 

Main Memory 32Mbytes or 64Mbytes flash ROM memory, 
DiskOnChip device  (100 nsec access) 

RAM Memory 64Mbytes, 128Mbytes or 256Mbytes 100MHz 
SDRAM (10 nsec access) 

Video Interface MediaQ MQ-200 
2Mbytes VGA local memory 

Internal LVDS interface to LCD panel 

External HD15 CRT (analog monitor) connector 

Ethernet PCI 10/100BaseT 

Intel 82559 MAC 

RJ-45 connector with indicator LEDs 

Other CPU I/O Two RS232 serial ports (COM1 and COM2) 

ECP/EPP Parallel port  

Two PS/2 ports for keyboard & mouse connections 

Two USB ports 

Output Relay 

System Hardware 
Monitor 

Battery 

+3.3V supply 

+5V supply 
+12V supply 

Temperature  
 
 

The RAC6182 Industrial Computer contains a boot ROM that contains 
the basic routines required to start up the RAC6182 computer and load 
the Windows CE operating system from the DOC flash ROM into the 
computer DRAM.  The boot code can be field upgraded coincident with 
an operating system upgrade. 

Appendix B 

Processor Board 
Specifications 

Boot Code Information 
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RAC6182 Compatible Devices  

The Windows CE operating system includes a PCL3 printer driver.  This 
driver supports printing on most laser and ink-jet printers.  If you 
experience problems using a printer, verify that your printer is 
compatible with the PCL3 print driver.  

The following printers have been tested and are known to work 
satisfactorily with the RAC6182 Industrial Computer:  

• HP LaserJet 5 

• HP LaserJet 2100  

• HP DeskJet 1600CN 
 

The following PC cards are compatible with the RAC6182 Computer: 

  M-Systems ATA Flash PC Card 2000 
  SanDisk Flash Disk PCMCIA PC Card ATA 
  SimpleTech ATA PC Card 
 

 

Appendix C 

Parallel Port Printers 

PC Cards 
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RAC6182 Point-to-Point 
Communications  

The following table defines the wiring needed to the serial 
communication (COM2) cable.  This cable is needed to transfer debug 
output to a host computer or perform data exchange via Microsoft 
ActiveSync. 

Table Q 
Null Modem Cable (6189-2NMCBL) 

Signal Name DB9 (Female) 
Pin to… 

DB9 (Female) 
Pin 

Signal Name 

DCD 1 7,8 RTS, CTS 

RX 2 3 TX 

TX 3 2 RX 

DTR 4 6 DSR 

GND 5 Open Open 

DSR 6 4 DTR 

RTS 7 1 DCD 

CTS 8 1 DCD 

RI 9 Open Open 

SHIELD 10 10 SHIELD 
 

Appendix D 

COM2 RS232 
Communications 
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1 

12.1 in keypad bezel operation 
Connecting a keyboard, 8-11 
Installing the Keypad Configuration Utility, 8-9 
Keypad default key assignments for 
programmable keys, 8-32, 8-33 
Setting up and using the Keypad Configuration 
Utility (KCU) software, 8-8 
Using the Keypad Configuration Utility, 8-11 

12.1 in. version with keypad, dimensions, 2-3 
12.1 in. version with touchscreen, dimensions, 2-4 

6 

6182 Computer 
communications settings, 13-1 
compatible devices, C-1 
connecting external devices, 3-1 
connectors, 1-8 
display settings, 9-1 
features, 1-5 
hardware monitor, 11-1 
installation, 2-1 
keypad, 8-1 
opening chassis, 4-2 
operating recommendations, 6-1 
removing chassis, 4-2 
resetting, 12-1 
resetting Windows CE registry, 15-4 
restoring to factory configuration, 16-2 
specifications, A-1 
system checkout, 6-1 
touchscreen settings, 10-1 
user applications, 14-1 
versions, 1-1 
watchdog timer, 12-1 
Windows CE operating system, 7-1 

7 

7.7 in. version with keypad,dimensions, 2-3 

A 

ActiveSync. See Microsoft ActiveSync 
Add-in cards, thermal considerations, 4-2 
Applications 

compiling, 7-1 
installing, 7-2, 14-1 
standard Windows CE applications, 7-2 

B 

Backlight tubes, installing or removing, 5-1 
Battery, replacing, 16-2 

C 

Chassis 
removing, 4-2 

Clearances, 2-2 
Communications settings, 13-1 
Compatible devices, C-1 
Connecting 

diagnostic relay output, 3-9 
external video monitor, 3-8 
keyboard, 3-3 
mouse, 3-3 
network, 3-4 
parallel devices, 3-7 
serial devices, 3-6, D-1 
USB devices, 3-2 

Connectors, 1-8 
Cutout dimensions, 2-5 

D 

Diagnostic relay output connections, 3-9 
Diagnostics, hardware, 11-1, 15-1 

Index 
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Dimensions 
12.1 in. version with keypad, 2-3 
12.1 in. version with touchscreen, 2-4 
7.7 in. version with keypad, 2-3 
non-display version, 2-4 

Disk-On-Chip devices 
adding or removing, 4-1, 4-9 
memory usage, 7-7 

Display settings, 9-1 
DOC device. See Disk-On-Chip devices 

E 

Ethernet connections, 3-4 

F 

Files, transferring, 14-3, 14-4 
Flash memory. See Memory 
Front bezel assembly 

cables, installing or removing, 5-1 
disassembling, 5-2 
installing or removing, 5-1 
plastic overlay, installing or removing, 5-1 

H 

Hardware monitor, 11-1, 15-1 

I 

Installation 
clearances, 2-2 
cutout dimensions, 2-5 
dimensions, 2-3, 2-4 
mounting hardware, 2-1 
panel mounting, 2-5 
power, 2-7 
relay output, 2-8 
tools required, 2-2 

K 

Keyboard connections, 3-3 

Keypad, 8-13 
configuration, 8-7 
layout, 8-1 
legend strips, 5-6 
operation, 8-1 

Keypad Configuration Utility (KCU). See 12.1 in 
keypad bezel operation 

Keypad legend strips 
installing or removing, 5-1 

L 

LED indicators 
description, 1-9 
resetting the Diagnostics LED, 11-1 

Legend strips. See Keypad legend strip  

M 

Maintenance, 16-1 
cleaning the display, 16-1 
replacement parts, 17-1, 17-2 
replacing the battery, 16-2 
restoring to factory configuration, 16-2 

Memory 
adding or removing, 4-1, 4-8 
battery-backed non-volatile RAM, 7-8 
boot flash ROM, 7-7 
Disk-On-Chip flash ROM, 7-7 
flash memory PC cards, 7-8 

Microsoft ActiveSync 
applications, 7-2 
installing, 14-1 

Mouse 
connections, 3-3 
disabling the mouse cursor, 10-3 

N 

Network connections, 3-4 
Non-display version, dimensions, 2-4 
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O 

Operator access, 6-1 

P 

Panel mounting, 2-5 
Parallel device connections, 3-7 
Parts, 17-1, 17-2 
PC cards 

adding or removing, 4-1 
compatible cards, C-1 
memory usage, 7-8 

PC Link application, 7-2 
PCI add-in cards, adding or removing, 4-1 
PCMCIA cards. See PC cards 
Power connections, 2-7 
Printers, C-1 
Processor board specifications, B-1 

R 

RAM. See Memory 
Registry, resetting Windows CE, 15-4 
Relay output connections, 2-8 
Restoring to factory configuration, 16-2 

S 

Serial devices 
connections, 3-6 
null modem cable requirement, D-1 

Setup, initial operation, 6-1 
Specifications 

general, A-1 
processor board, B-1 

Storage Card memory, 7-7 
System lockup recovery, 12-1 

T 

Touchscreen settings, 10-1 
Transferring files, 14-4 
Troubleshooting 

check lists, 15-2 
hardware diagnostics, 15-1 
procedures, 15-1 
restoring to factory configuration, 16-2 

U 

USB devices, 3-2 
Using, 8-11 

V 

Versions of 6182 Computers, 1-1. See also 7.7 in. 
display version, 12.1 in. display version, Non-
display version 

Video monitor connections, 3-8 

W 

Watchdog timer, 12-1 
Windows CE applications 

installing and removing, 14-3 
transferring files, 14-4 

Windows CE operating system, 7-1 
architecture, 7-1 
benefits, 7-1 
compiling applications, 7-1 
Control Panel applications, 7-6 
installing applications, 7-2 
interface, 7-3 
memory usage, 7-7 
registry, 15-4 
standard programs, 7-2 
upgrading, 14-4 
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